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Introduction to Celestia

Many of us have looked up at the stars on a dark night and wondered what it would be like to launch ourselves into space and soar among the stars.  What do the astronauts of the Space Shuttle really see when they look down upon our beautiful Earth turning slowly below?  What wonders might we encounter if we could visit Saturn alongside the Cassini spacecraft and sail right through its rings?  If you have ever wondered about these things and would like to find the answers, we of the Celestia community are happy to introduce you to Celestia!

Celestia is a free real-time space simulation that lets you visually experience our universe in stunning three dimensions.  Celestia was the initial inspiration and creation of Chris Laurel, a Seattle, WA computer programmer who in 2001, decided to write a free software program to be made available to everyone on the world-wide-web that would place you in control of a virtual reality world of the universe.  His vision and dedication gave birth to a program that is unlike any other space simulation program in existence.  Celestia doesn't confine you to the surface of the Earth as do many other programs.  Instead, Chris created a dynamic capability to travel throughout the Solar System and elsewhere in space, at any speed, at any moment of time and in any direction you choose.  If you wish, you can fly via your own “hyperdrive” spacecraft to visit stars within the spiral arms of the Milky Way beyond the confines of our Sun, or leave the galaxy entirely to view the bigger universe from deep space.  Chris also insisted this program would be scientifically accurate … a true source of dynamic astronomical graphics.

When Celestia version 1.0 first appeared available for download on the Internet, space enthusiasts all over the world discovered and quickly realized the potential of this beautiful program.  Within a year, many talented people worldwide joined Chris in a collaborative volunteer effort to make Celestia into not only a good graphical space simulation but into a great one, capable of producing a meticulously accurate virtual universe rivaling the visual quality seen only in Hollywood films.  

They have succeeded.  As of this writing, over 7,300 members of the public are part of the Celestia forum community.  Over 7 million people have downloaded the program for use at home or school.  It is in use in homes, schools, government agencies and media outlets throughout the world.  The contributor list grows daily and includes talented graphic artists, computer programmers, astronomers, astrophysicists, planetarium directors, animators, engineers, teachers and students, professionals from government, private occupations and ordinary citizens in over 25 countries.  Together, they have created a world of space that utilizes not only the basic Celestia program, but over 18 gigabytes of add-ons and extras that truly bring your Celestia experience to life.  We invite you to join the Celestia forum by clicking here.   

Celestia 1.6.0 is available free of charge for Windows, Linux, and Mac OS X from http://www.shatters.net/celestia/download.html.  Hopefully, you’ve already downloaded Celestia and are ready to install it and experience the beauty of space.  Using some of the add-ons available for the program, here is just a taste of what you will be able to encounter:

· Learn the unbelievable size and magnitude of our universe firsthand, with a journey from the surface of Earth to the far reaches of the galaxies … at hyperspeed.
· Watch solar flares and prominences rising off the Sun and measure its rotation using sunspots.
· Hover over each of the planets in our Solar System as they rotate slowly below you.  See clouds drift by (where applicable) and shadows being cast on mountains and craters as the Sun sets low.
· Fly along with Mariner 10 on its historic flyby of Mercury.
· Visit the searing surface of Venus and view it in a panoramic 360° vista. 
· Take a spin down to the Earth’s surface in your own hyperdrive spacecraft.  Skim over the oceans of Earth as you fly below the clouds.  Soar back into space to see the lights come on in the cities of Earth.
· Be present as Apollo 11 lands on the Moon in 1969, or fly by Sputnik 1 in 1958 shortly after its launch.
· Rendezvous with the ISS or the Hubble Space Telescope.  Attempt a docking at the ISS Shuttle port. 
· Peer through the primary focus from inside the Hale Telescope on Palomar mountain. 
· View Earth’s Magnetic Field from space and see the Aurora glowing and shimmering.
· Display an internal X-section of Earth and peer deeply into its tectonic layers and structure.
· Discover Mir as it passes over the Russian homeland with its cosmonaut crew onboard.
· See the massive size of Hurricane Katrina as it makes landfall on New Orleans.
· Utilize over 1 dozen science texture maps of Earth, to include oceans and seas, coastlines, volcanoes, earthquakes impact sites, world cities, temperature extremes, tectonic plates and boundaries, etc.
· Hover over Mar’s Gusev crater and Meridiani Planum and drop down to visit Spirit and Opportunity, then fly over to Olympus Mons and Valles Marineris and fly through the canyon itself.
· Be there in the year 2029 when the asteroid Apophis will approach Earth on a possible collision course.
· Observe a spectacular lunar eclipse of our own Moon and a total solar eclipse on Earth.
· View our Asteroid Belt from high above, watching as its millions of members orbit the sun
· Position yourself above Jupiter and watch as its large moons drift across the face of the planet, casting multiple eclipse shadows on its banded clouds and Great Red Spot.  
· Examine the actively erupting volcanoes on Jupiter’s moon Io.  Fly through a spewing volcanic plume.
· Hover far beyond Saturn, plunge through its rings, and count its 60 moons.  
· Witness Cassini arrive in Saturn space in 2004 and drop the Huygens probe into the atmosphere of Titan in January 2005. Follow Huygens down toward a parachute landing on Titan’s surface.
· Journey to the frozen wasteland of Pluto and its three moons and see their icy coldness for yourself.
· Take up station behind comet Halley in 1986 as its gaseous lavender tail streams out behind it near Earth.
· Seek out Ceres, Eris, Makemake and Haumea, our Solar System’s newest “dwarf planets”.
· Fly out to the edges of our Solar System and follow Voyagers 1 and 2 as they head to distant stars.
· Witness the impact of the Deep Impact spacecraft onto the surface of comet Tempel1 in July 2005.
· Set your ship at faster-than-light speed and sail to Rigel Kentaurus A, located 4.3 light years away.
· View the red glow of sunlight on Gliese 581c, an earthlike world orbiting it’s small red dwarf star.
· Travel in time to 3000 CE to witness giant mirrors melt the Martian polar ice caps and help to terraform Mars into a verdant world of water, plants and cities of the future.  
· Travel far into the future and rendezvous with a colossal rotating Space Station as it orbits Earth.
· Journey to the edges of a massive rotating Black Hole as it spins near its stellar companion.  Witness another Black Hole swallowing its companion star.
· Travel to the heart of Betelgeuse, a distant Red Supergiant star that will Hypernova someday.
· See stellar creation from deep within the Rosette and Eagle Nebulas, giant stellar nurseries.
· Observe for yourself the deep field galaxies that were photographed by the Hubble Space Telescope.
· Hear the pulses of the new pulsar in the Crab Nebula, spinning before you at over 30 times a second.
· Witness the end of Earth, as it is swallowed by our swelling Red Giant sun billions of years from now.
· Jump at hyperspeed to the Andromeda spiral galaxy, M 87 located in the rich Virgo Cluster or the beautiful Whirlpool galaxy, or visit over ten thousand galaxies, accurately drawn.
· Cruise next to Cosmos, a revolutionary new spacecraft that may someday “sail” on a wind of pure sunlight. 
· Travel backward in time 4 billion years to witness the planet “Orpheus” catastrophically collide with Earth to actually form our Moon.
· Learn what efforts are being taken to discover if extraterrestrial intelligence exists in the universe.
· Take a detailed scripted journey through the Zodiac and another through Conjunctions and Occultations.
· Travel in tandem with the USS Enterprise commanded by Captain Picard as it battles the Borg Empire.
· Travel in the whimsical world of Hollywood and visit the StarWars® worlds of Tatooine, Endor and Hoth.  Fly next to the Imperial Death Star or Star Destroyer as the Millennium Falcon swoops in for an attack.
· Experience a 1-hour scripted journey through the tableau of “2001, a Space Odyssey”.
· Fly directly through a theoretical wormhole on your way to a distant solar system.
· Explore numerous fictional solar systems, complete with meticulously detailed, exotic alien civilizations, terraformed moons, futuristic space stations, space fleets, and interstellar spacecraft.
· Visit Pandora, the beautiful fictional world made famous by the smash hit movie, Avatar.  
These are just a few of Celestia’s features.  Each week, new features are being added by Celestia’s programmers and other talented contributors.  It is a program undergoing a rapid evolution in computer graphics.  Add-on features, for example, will include entirely new solar systems with dozens of planets and moons drawn in vivid detail, sound effects, gaseous nebula clouds, new galaxies, stars, globular clusters and spacecraft both real and imaginary.  Periodically as new features are added, this User’s Guide will also be revised.  If this list above excites you, let’s get started on our journey into the heart of Celestia.


Demo

Celestia is a stunning program to observe and explore the Solar System and beyond.  To help you discover a few of its beauty and secrets, Celestia has a short journey already laid out for you.  To see it, launch the program as described below, and press the [D] key.  When done, press the [Esc] key.  


Scripts

Celestia developers have created scores of other scripted journeys that take you to a variety of fascinating places as a spectator.  To access and download them, visit Celestia’s “add-on” repository website at http://www.celestiamotherlode.net/catalog/scripts.php.  Download the script of your choice and place it in the Celestia/Scripts folder located at C:\Program Files or C:\Program Files (x86) directory or in the MAC or Linux Applications folder.  You can then launch it from within Celestia (see later instructions).  These scripted trips take anywhere from a minute or less to over an hour.  Scripts are also available on many forum member websites.  


Educational Journeys

The extraordinary ability of Celestia to educate the public about Astronomy has also led to the development of a series of Educational Activities that take Celestia users on extensive, detailed virtual tours of the universe, some lasting several hours.  Designed for all general audiences and for students in 7th – 12th grades (ages 12 -18) and in college introductory courses in Astronomy, these exciting Activities teach you a host of facts about specific astronomical topics, while employing the stunning ability of Celestia to give you control of your own spaceship to explore the universe at your own speed and pace. Unlike a script, you participate in an educational journey not as a spectator but as pilot of your own spacecraft.  Each journey includes student worksheets that can be printed, copied and distributed by teachers to students for a grade, and meet all National Educational Standards in Science.  Many of the highlights mentioned above are taken from these Educational Journeys.  

There are 12 journeys currently.  They are available at no charge for download individually as zipped files, from http://www.celestiamotherlode.net/catalog/educational.php.  They require about 2.5 GB of computer memory.  They can also be purchased on a convenient, self-installing CD or DVD set for a modest fee from the author.  Details are on the author’s website at http://gregs-educational.info/.


Celestia on Wikipedia and Wikibooks

Celestia is a growing topic on Wikipedia, and on Wikibooks.  Those sites contain some impressive additional tutorials on how to operate the program, create add-ons and design scripts.  Visit them at http://en.wikipedia.org/wiki/Celestia and http://en.wikibooks.org/wiki/Celestia.  Once you become familiar with the program, we invite you to contribute to these two sites.



Program download and add-ons

Celestia is a computer program written in the computer language C++.  The code is Open Source, and may be examined and modified by anyone under the terms of the GNU Public License.  If you have an interest in joining the volunteer Celestia development team, contact Chris Laurel at claurel@shatters.net. 

In addition to the actual program, Celestia can include many other add-on files (graphics and data).  If you choose to download the library of over 500 Celestia add-ons designed to date by its many contributors, they can take up over 18 GB (gigabytes) of disc space.  For many people with limited computer memory and/or internet download speed, that is very large.  To offer Celestia in a reasonable fashion, therefore, the basic default program is provided for download with a comprehensive but limited set of files, sufficient to experience its capabilities without overtaxing your computer.  “Links” (web addresses) to guide you to the additional add-on files available are listed on the web within the User’s forum and the Celestia website.  To fully experience what Celestia has to offer, we urge you to seek out and download some of these other add-on files.  

Fortunately, volunteers have assembled a central repository for many of them.  It is not complete but is growing rapidly.  Its web address is:http://www.celestiamotherlode.net/ and should be your first stop for add-ons.

The Celestia Educational Activities mentioned above contain a compilation of some of the best add-ons.  As mentioned, the activities can be downloaded individually at no charge, or purchased as a CD set.  See the educational website at http://www.celestiamotherlode.net/catalog/educational.php for details.  

You can find other add-on sites here:

http://www.ikiru.ch/celestia/index.php?lang=en		Celestia matters					
Praesepe's Files						Mike’s add-on list
BT’s Celestia add-ons					Celestia basic textures
Selden’s Resources					http://celestiasws.free.fr/index_en.html
Jack’s spacecraft add-ons				Jim’s Celestia page
Maxim’s site						http://fsgregs.startlogic.com/Public_Files/Cham/" http://fsgregs.startlogic.com/Public_Files/Cham/
Please note that the above links may be temporary.  Websites come and go based on member’s arrangements with hosting servers.  However, the above sites are an excellent start.  To see links to more of them, visit and browse the forum at http://shatters.net/forum/index.php.  

The Celestia default program and package for computers running Microsoft Windows® 98, XP, Vista or 7 is offered as a fully “executable” program.  It will install itself onto your computer.  The current version is Version 1.6.0, and was released in 2009.  Celestia 1.6.0 is also available for the Macintosh using the OS X operating system, and for Linux.  The Windows®, MAC and Linux versions are all available for download at Celestia’s main site located at http://www.shatters.net/celestia/download.html" http://www.shatters.net/celestia/download.html.  

Required Linux Libraries: Which version of Celestia you choose to install depends upon which desktop environment you have installed.  If you do have KDE3, it is recommended that you choose the KDE version of Celestia.  For those running GNOME, there is the option of downloading or compiling the GNOME front-end, which includes several integration features with the desktop environment. There is also a simplified GTK+ interface, without GNOME features, for those who prefer the minimum number of outside libraries. Most distributions package Celestia themselves. The Celestia SourceForge download page also provides a pre-compiled package with the GTK+ front-end.  All versions of Celestia for Linux require that you have OpenGL installed.  More and more distributions are shipping with OpenGL, so if you’ve recently installed or re-installed Linux, there’s a good chance that you already have a working OpenGL configuration.  In order to build Celestia, you need to have the OpenGL development packages installed. Celestia requires the image libraries libjpeg and libpng to both be present on all up to date Linux installations.  In order to build the GNOME/GTK+ front-ends, the gtkglext library is required.  All of these libraries and their required development packages should be available from your distribution. After you’ve successfully built Celestia, you will want to be able to run it with hardware 3D acceleration.  To take full advantage of your graphics chip, download the X.org driver provided by the maker of your video chip. 


Computer Hardware Requirements

Celestia is a sophisticated program that not only positions and graphically depicts our complete Solar System in 3D; it also plots and tracks a sky full of thousands (to millions) of stars in real time.  This takes computer power and computer memory.  Celestia also has available hundreds of add-on files.  Some of them are large model and graphics files that require lots of RAM memory.  Thus, identifying what level of computer performance you need to enjoy the program depends upon what level of detail you wish to achieve.

In general, to run the Celestia 1.6.0 program with a reasonable number of add-ons, your computer should have the following capabilities:
1. A CPU speed of at least 1 GHz 
2. An operating system running Windows® 98, XP, Vista, or 7, MAC OS 10 or Linux
3. RAM memory of at least 512 MB  (1 GB or more is preferred)
4. Open GL video graphics card with at least 128 megabytes of video RAM
5. Free memory on your hard drive of at least 3.0 Gigabytes
6. A 14” or bigger color monitor, or LCD/front projector and screen
7. Computer sound speakers (optional)
8. Mouse and keyboard
9. Internet connection (optional)
** PLEASE READ CAREFULLY:  Celestia uses the OpenGL process to render 3D graphics.  In order to get the most from Celestia, you should have a modern OpenGL graphics card with the latest drivers from the manufacturer.  If you have problems running Celestia, verify that your graphics card is capable enough to run Celestia, and that the drivers are up to date.  If in doubt about the OpenGL driver, download and install a new one.  It will be available free from your card maker’s web site.

Please Note:  While a graphic video card might use Open GL processing, Celestia does not run well on all such card brands or models.  Several graphic cards handle images in a manner that Celestia may not control properly.  If a compatible Open GL card is not present in your computer, Celestia can still offer you a beautiful space experience, but some of its advanced features may not display.  These include shadows on mountains and craters, sunlight reflections off water (specular highlights), shadows of moon eclipses, and atmospheric haze. 
     
As development of Celestia continues, additional support for graphics hardware will continue to be introduced.  If not all the features of your graphics card are supported yet, be patient.  Better yet, if you understand C++ coding, join the Celestia development team and help improve the program.

For key information on video graphics cards, please see the section below titled, “Rendering and Resolution”.    


Installation, Updating and Uninstallation

Windows Operating System (98, XP, Vista or 7):
Once you have obtained and downloaded the executable file from the Celestia website, simply click twice (double-click) rapidly on its name with your left mouse button.  You should install Celestia in the default directory your computer prefers for general programs.  In general, that is located at C:\Program Files.  However, because Windows Vista and Windows 7 are 64-bit software programs, they have to make adjustments to run 32-bit programs like Celestia.  To do so, they may create a special location on the hard drive for such programs.  That location is typically:  C:\Program Files (x86).  

Because Celestia is a 32-bit program, it should be installed in the default directory that Windows Vista or 7 places it.  In general, just click “Next” whenever it asks a question.  Celestia has its preferred choices and unless you have good reasons for altering them, we suggest you follow them.

Macintosh OS X Operating Systems:
To install the Macintosh version, click on the installation file and follow the on-screen menu instructions.   We recommend installing the program in the Applications folder.  

Linux Operating Systems:
Most distributions package Celestia to best suit their users' needs. Check with your package management software, as there is a good chance that Celestia is present there.
Alternatively, there is a precompiled x86 AutoPackage provided on the SourceForge download site.  This package uses the GTK+ front-end, and should run on most computers.  Information about installing an AutoPackage is here:   http://www.autopackage.org/docs/howto-install/ 
Finally, should you wish to compile Celestia yourself, the process is fairly straightforward.  Unpack the tarball:     celestia-1.6.0.tar.gz 
Then change directory (cd) into the newly created directory and configure Celestia.  Run configure with the appropriate command line for the version that you want to compile:     KDE     ./configure --with-kde     GNOME     ./configure --with-gnome     GTK+     ./configure --with-gtk 
The configure script may complain if you are missing a required component, or if you have an out of date version of a required component. Check the error output to determine what's missing, install the necessary items, and then try re-running configure.  If neither the KDE or GNOME versions of Celestia will build, try falling back to the GTK+ version. There are many options for configure; you can view them all with a brief explanation for each-by running ./configure --help. After running configure, compile and install Celestia:     make     make install Note:  make install will need to be run as root unless you've overridden the default install directory by invoking configure with the --prefix option.


Updating your Celestia installation:  
When a new version of Celestia comes out, it is a good idea to uninstall an older version and install the new one, while archiving any add-ons or other files you may have loaded into your Celestia folder in a safe spot.  The reason is compatibility.  Newer versions of Celestia may or may not work well with some of the files from older versions.  Once the new version is in place, you can drag your add-on files back into the new Celestia folder, and test them out for compatibility.
Alternatively, you can choose to install the new version of Celestia in a different folder.  Simply name a new destination for Celestia during the installation of the new version.  For example, you can call it “Celestia 160”.  Then, you will be able to launch and run either version of Celestia as you choose, by simply opening the program from either folder. 


Uninstall:  
To uninstall Celestia in Windows, click the Start button at the bottom left of your screen, select “Settings”, then select “Control Panel”, then select Add/Remove Programs.  Locate Celestia in the list that appears and click the button that says, “Add/Remove”.  For Apple, LINUX/UNIX owners, follow your system’s uninstall procedure.


Note:  In the sections that follow, images and screenshots from the program are displayed.  Many of the images use higher-resolution graphics that are not part of the default download program, but which are available from the Celestia forum and other websites as add-ons.  As a result, if your version of Celestia does not precisely match the enclosed screenshots, don’t be alarmed. 


Note:  In the following Guide, many keystroke commands will be referenced.  All keystrokes will be enclosed inside a square bracket [  ].   Since all of the letters on a modern keyboard are in capitals (e.g. – K or L or M), keystroke references will be in capitals also (e.g. – [ K ] means press the “K” key).  You do not have to use the [Shift] key.  On occasion, however, a keystroke will require the use of an actual capital letter, such as the capital letter “T”.  If that happens, we will instruct you to press both the [Shift] key and the [T] key.  For example, the instruction will read, “Press the [Shift+T] keys”.  If the keystroke is a symbol that requires the use of the [Shift] to reach such as a colon [:] or an asterisk [*], please press the [Shift] key at the same time as you press the symbol keystroke.  For example, to type the & sign, you would actually press [Shift] and the [ 7 ] key at the top of the keyboard, together at the same time.  Some keystrokes require the use of the [Ctrl] key or [Alt] key.  When they do, we will instruct you.


IMPORTANT NOTE: on occasion, we will instruct you to “Click here” to actually launch a scene in Celestia.  It is VERY important that you click that link ONLY ONCE.  If you double click it, two separate versions of Celestia will launch.  Since the program uses a lot of memory and computer resources, two programs running at the same time will lock up your computer or slow things down dramatically. 

Also note that in Microsoft Word or OpenOffice, you may have to hold down the [Ctrl] key while you click “here”. 


General Operation and Keyboard commands

1) To launch Celestia, double-click on its icon on your desktop or single-click in the Programs menu that appears when you click your Start button.  The program will load and will position you out in space.  The beauty of Celestia is its accuracy.  The image in front of you is exactly what you would see if you were really positioned in space inside a spaceship at that very spot at that particular time, looking out your ship’s front window.  In other words, Earth, Mars, and all of the planets, moons, stars and spacecraft visible on your screen really are located in space where Celestia has put them.  
[image: ]The Opening Screen


Figure 1- Earth

Click here ONCE ONLY 
to go to Earth (if needed, press
[Ctrl] + click.



2) Earth turns on its axis constantly and is always changing position.  Thus, the screenshot above may or may not be the same scene you see when you open Celestia.  However, it will be similar.

3) Maximize your screen by clicking the middle box in the top right corner (Windows systems) or by following your MAC or Linux technique for doing so.
4) In the top left corner of the screen will be some information about your target (Earth) (if you see no text, press the [V] key twice on your keyboard).  “Distance” gives you the distance from the surface of the object to your viewpoint.  The Radius of the object will be listed in kilometers.  The Apparent Diameter will be a value in degrees representing the size of the object in front of you as seen from your current viewpoint.  If you move closer or farther away from the object, its apparent diameter will get larger or smaller respectively.  The Phase Angle is the angle of reflection of light off of the object in your view.  In an angle of 0o, the sun is directly behind you and there is no reflection bounce.  An angle of 90o means the sun is 90o to your left or right.  Rotation Period is in hours, and Temperature of the object is in degrees Kelvin.
5) In the lower left corner will be your Speed through space.  At the moment, your “ship” is stopped (relative to Earth) so your speed is zero.  Later, we will begin to fly on our own and your speed will be listed here.  
6) In the top right corner will be the current date and time.  In Astronomy, times are given in Universal Time (UTC) (commonly referred to as Greenwich Mean Time), and this is what Celestia uses by default.  The date and time are in the format (Year, Month, Day, Hours: Minutes: Secs).  Thus, 2008 Jul 25 14:10:06 UTC means that the time is July 25, 2008 at 2:10:06 PM.  You can access the Time menu at the top of the program screen and command Celestia to show local time zone instead.  Celestia can also speed up, slow down, or travel forward or backward in time.  For example, in the opening scene, the program is running “100x faster”.
7) In the lower right of the screen will be a message telling you that you are “Following” Earth.  Wherever it goes, you go.  Thus, although Earth is actually moving rapidly through space, you are moving with it.  


Field of View (FOV):   [ shift + left-click+drag] or [ , ] or [ . ]

8) Under the “Follow Earth” text will be your “Field of View” or “FOV” setting.  This is the amount of sky your view takes in.  Celestia starts you out with an FOV that it calculates, based upon your monitor settings.  It ranges from 15° to 45°, which means your monitor is displaying about 15° - 45° of the sky (most people have a total visual field of 120°).  However, you can change the FOV by holding down the [Shift] key on the keyboard, [left-clicking] your mouse and dragging the mouse forward or backward.  Try it.  As the FOV gets smaller, the scene enlarges.  It is similar to a telescope magnification.  You can also press the [ . ] or [ , ] keys to change field of view from the keyboard.  Enlarging the FOV allows you to magnify objects, while still keeping the planet in the foreground.  In general, an FOV of between 25°- 35º presents a sky view that draws objects at about the size you see them in space.  If you wish to return to the default FOV that your program opened with, click/push your mouse [wheel button] down once.  Please note that if you change your screen window size by dragging its borders, Celestia will change the FOV, based on the new screen size.
9) You can also instruct Celestia to launch the program with a particular starting FOV, rather than sizing it based on your screen settings.  To do so, locate the file named “start.cel”, which is in the Celestia main Directory folder.  Right-click on it and choose the option that says, “open with”.  A list of programs on your computer will appear.  Locate a text-editing program such as MS WordPad or Notepad and click OK.  The start.cel file will open and you’ll see a set of single line commands (in English).  Locate the line that says, 
# “set {name "FOV" value ____ }”.  Remove the # symbol and in the space, type whatever FOV value you wish.  For example:
set { name "FOV" value 30.0 } produces a 30° field of view that is about what your eyes would see without a telescope if looking at the Moon. 
Save the file, close it and launch Celestia.  The program will now always start with an FOV of 30°.
	Figure 2  - click here to visit				Figure 3 – click here to visit
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The FOV here is 45°.  Notice size of the moon behind Earth.	    The FOV here is 12°.  Earth and moon are now enlarged.
Rendering & Resolution: [Ctrl + V], [Render Resolution menu].    

10) Celestia is a sophisticated graphic drawing and rendering program that draws objects using “models” it has in its database.  It then wraps various graphic textures and images around those models.  
11) There are three levels of textures it can use.  They are “High-Resolution Textures” (known as “hires” textures), Medium Resolution Textures (known as “medres” textures), and Low Resolution Textures (known as “lores” textures).  You can find those graphic files in the Celestia main directory, inside a folder named “textures”.  The program model patterns can be found in a Celestia folder named “models”.  
12) Celestia also can contain customized “add-on” files, which are additional models, textures and code documents that Celestia designers may offer to users.  These add-ons are typically located or placed in a Celestia folder named “extras”.  Each add-on may be inside its own folder in the extras folder, and may contain its own models and textures.
13) The level and method of drawing/rendering capability that Celestia can use is determined by a piece of hardware in your computer called a “Video Display Adapter”, or Video Graphic Adapter”.  All computers have one, but they come in many different models.  Some adapter “cards” are built into the computer, and are typically modest in graphic drawing capability.  Others are added by users as separate plug-in cards, and can cost hundreds of dollars.  
14) All video cards are programmable, meaning that a separate piece of software in your computer (called a video driver) controls what the circuitry does.  Obviously, this software is pre-loaded onto your computer when you first buy it.  However, video card designers constantly write new software driver code that frequently will improve the performance of your display adapter card, without you needing to buy a new one.  To run some of the recent gaming software available, updated video driver software is a MUST.  To get such a driver, you need only to visit the website of the display adapter manufacturer or your computer manufacturer, and download and install the latest software drivers for your video card.  They are free.
15) To update a video driver, first identify what model of video display adapter card you have.  To do this in Windows, open the “Control Panel” (accessed through the Start button), choose “System”, then “Hardware”, then “Device Manager”.  A list of hardware components in your computer will appear.  Choose the one marked, “Display Adapters”, click the (+) button next to it, and the name of your Video Display Adapter card will appear.  Once you know that, go to the website of your computer manufacturer (e.g. – HP, Apple, Dell, etc.) and look for links to download “graphic drivers”.  You can also go to the website of the video card manufacturer (Nvidia, ATI, Radeon, Intel, etc.) and download the newest drivers from there.  Somewhere on those websites will be directions on how to install the new drivers on your computer.  Alternatively, you can hire a computer store to load them for you.
16) Celestia will “read” the type of video display adapter and driver you have and will select a drawing method it feels is best for that adapter.  From that perspective, therefore, you don’t have to do anything specifically.
17)  Celestia offers you the ability to compensate somewhat for lower level display cards by allowing you to choose which level of graphic rendering you desire, and which resolution of textures you may wish to use (High, Medium or Low).  These choices are selected by menu commands.  For example, if you have a fast computer with a good video card, you would use the highest resolution your system can handle without sacrificing performance.  Conversely, if your system is a model with only a modest video graphics card, you would want to lower the resolution and/or rendering options to avoid overtaxing your system.
18) Vertex Shading Render Paths - [Ctrl + V].  Vertex Shading is a computer graphics drawing technique that creates shades (haze, shadows, specular reflections off water or ice, etc.) on Celestia objects.  To see such shading, you must have a graphics card that renders shading via the Open GL process.  With higher end graphics cards, Celestia 1.6.0 gives you several choices for Vertex Shading.  Each card manufacturer results in slightly different shading choices.  For example, with Nvidia brand video cards, there are five Render paths: Basic, Multitexture, Open GL vertex program, Open GL vertex/Nvidia Combiners and Open GL 2.0.  Pressing the [Ctrl + V] keys together will cycle through the choices.  A message will appear on your screen, stating what rendering choice you have selected.
19)  These shading choices affect how fast your computer will draw the scene, and what kind of performance you will see. By default, Celestia detects your graphics card and starts the program with the highest quality rendering possible (usually OpenGL 2.0).  Using the [Ctrl+V] keyboard shortcut, cycle through the choices.  You will see surface shadows, reflections from oceans and a haze appear or disappear on Earth.  If you have another brand of graphic accelerator card, cycle through whatever choices Celestia presents to you.  If you have no graphics card at all (i.e. – your computer has a minimal built-in graphics processor), the Basic or Multitexture settings may be your only choices.  Many features are only visible if OpenGL 2.0 is enabled.
  
	Figure 4 – click here to visit					     Figure 5
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	       Open GL 2.0 render path selected		           Same scene with Basic render path only
	   

20) Texture Resolution - [Render menu/Texture Resolution].    Celestia opens for the first time with its texture level set to “Medium Resolution Textures”.  You may change this at any time by pulling down the [Render] menu at the top of the program, selecting Texture Resolution, and choosing High of Low.  Celestia will remember that choice and open at that resolution the next time it is launched.

21) Please note that in order to use a higher or lower resolution texture, Celestia must have such files in its database.  Hires textures and Lores textures are not always supplied.  For example, many add-on designers only draw a medres/medium texture level.  If you press the resolution keys and the image does not change, it simply means there is no higher or lower resolution texture in the Celestia database for the program to use.

22) Resolution is critical to an enjoyable Celestia experience if your computer has only modest graphic rendering capability, and you are using add-ons.  Some of them will cause your computer to lock up if you have selected High Resolution Textures.  Changing to Medium or Low resolution can improve performance (if such textures are provided).  
	   

23) Frames per Second (FPS) – [`].  Sometimes, it is useful to see how efficient or inefficient your video card is in handling certain scenes in Celestia.  You can of course, choose a high-resolution texture option and see if your computer locks up, or you can activate a keystroke command called “FPS”. To do so, press the [`] key (it’s above the Tab key on the keyboard).  In the lower left corner of your Celestia display, it will now list your “FPS”.  This tells you how many times per second Celestia draws the scene you are looking at.

24) To animate a scene and see it moving realistically, you must have an FPS of at least 6.0 or higher.  For example, to view a planet rotating or a spacecraft moving through space, FPS should be as high as possible (FPS values exceeding 100 FPS are possible with expensive video cards).  If the scene you are viewing is under 6 FPS and is moving, it will appear jerky to you.  If high-resolution textures or a particular rendering option causes your FPS to drop below 6 FPS, we recommend you lower the resolution, or select a different rendering option by pressing the [Ctrl + V] keys.   Please note that before the frame rates of a new resolution takes effect, you must close the program, then open it again.  


Set View Options (Render menu)

25) When you use Celestia for the first time, you will need to choose some options that will tell the program how you want things done. Celestia will remember these settings once you initially establish them.  However, during your subsequent use of Celestia, you may need to change or reset these options.
  
26) Display Mode:   To open the Render menu, [left-click] on the word “Render” at the top of the Celestia view screen and choose “Select Display Mode” or “Toggle Full Screen”.  These are instructions to Celestia to change the resolution of the view screen.  Choose the "Select Display Mode" menu first to choose the size of the viewscreen you prefer.  “Windowed Mode" is the default choice and sets your screen to the same resolution size your display monitor is set to display.  For example, older desktop computers display a default screen resolution of 1024 x 768 pixels, while newer systems and laptops are typically set to 1680 x 900 pixels or higher, in either 16 or 32-bit color.  To find out what your computer display is set at, [right-click] on your desktop, choose “properties” and “settings”, and read the monitor resolution setting.  

27) When running Celestia in Windowed Mode, your screen gives you visible screen borders, sliders and toolbars.  You can resize the screen by dragging its corners, minimize the screen, switch between programs, etc.  If instead you select a different screen resolution from the Display Mode pull-down menu, Celestia will immediately switch to Full Screen Mode and draw the screen in that pixel size, filling up the entire screen.  All of the toolbars, sliders and side borders will disappear.  

28) High-end computers and those with up-to-date video cards can take advantage of tighter packed pixel sizes and more detailed appearance, and some users prefer to view Celestia in Full Screen Mode at smaller pixel sizes.  The screen is uncluttered and your view really looks like the window in a spacecraft.  

29) However, there are disadvantages to Full Screen Mode.  First, in order to access the toolbars, you must point your mouse toward the top of the screen and wait for the menu/toolbar to be drawn.  With some video cards, the entire screen may go black for a moment as the toolbars are being drawn.  Secondly, some screen modes are simply not designed for certain monitors.  For example, if you set your resolution at 1280 x 720 on a regular CRT monitor, the screen will look warped and the planets will be ellipses, not spheres.  Also, be advised that the ability of Celestia to redraw complex scenes in different screen sizes varies from system to system.  Some users have reported lockups and program crashes when using Full Screen Mode at certain display sizes.  We recommend you experiment and choose the resolution that works best for you.  

30) [Alt+Enter] is a useful keyboard shortcut that toggles between Windowed Mode and Full screen. 

Note:  If you are in Full Screen Mode and wish to toggle between Celestia and another program, simply press the [Alt + Tab] keys together (Windows systems).   



31)   “View Options” is the third option in the Render menu, and an important one.  Left-click this option to open the View Options dialog box.  A list of choices will appear.  Deciding which ones you want is a personal choice.  If your computer is a newer model, we recommend the options listed in the image shown and described below.  If your computer is slower or older and Celestia appears to be running slowly, deselect some of these options, as suggested in the following discussion:

Note that Celestia will remember which boxes are checked so that you will not have to check or uncheck them each time you run the program.



Note:  Keyboard shortcuts to activate these options are listed in brackets below.
[image: ]
Galaxies  [ U ]  {E} Celestia comes with a galaxy data file that tells the program the position of over 10,000 galaxies in the night sky and what type they are.  When this option is selected by Render menu or by pressing the [U] key, Celestia will dynamically draw each galaxy based upon its type and magnitude, and position it in the proper place in space.  Since galaxies are dim objects and most are not visible without telescopes, not all 10,000 will be drawn at once.  {E} toggles galaxy labels.  
Celestia will also draw the huge band of starry haze we know as the Milky Way.  Selecting the option, therefore, will dramatically improve your Celestia experience and you will be able to see the Milky Way across the sky and several galaxies in the distance.  You can even travel to them in your spaceship.  
	

		Figure 7 – click here to visit				 Figure 8 – click here to visit
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Galaxy Brightness	   [Shift+ ( ] or [ Shift+ ) ]   These two sets of keystrokes increase or decrease the brightness of all galaxies, including the Milky Way, when pressed.  When visiting galaxies outside of the Milky Way, boosting brightness can improve your view of distant galaxies on different computer monitors and under different room lighting levels.  Press the keyboard controls above to reduce or increase brightness through 20 levels.

	Galaxy brightness will also respond to the AutoMag keys that control star brightness.  They are linked (see later discussion).  Pressing the bracket [ or ] keys alone will dim or brighten galaxies to some degree.



Globulars	[ Shift+U ]  {Shift+E}  Celestia 1.6.0 now displays hundreds of globular clusters, large groups of stars positioned near the outskirts of the Milky Way.  Many are above or below the disc plane.  {Shift+E} toggles Globular labels.   To visit a Globular, click here.  


Open Clusters	[ no shortcuts ]  Open Clusters are small star groups that have a  diffuse shape, and may contain as few as 30 stars, or may be larger.  Over 1,000 clusters occur in our vicinity of the Milky Way.  The default version of Celestia 1.6.0 does not come with a database of open clusters, but such a data file can be obtained as an addon from this website.  Once unzipped and installed in the Celestia “extras” folder, checking the Open Cluster render box, and checking the “Open Clusters DSO labels” box, will show you the locations of 1082 clusters.

 
[image: ]Nebulae	 [Shift+^] Toggling these keys activate nebula.  Currently, all nebulae in Celestia are “add-ons” provided by volunteers.  Dozens are available from the Celestia add-on repository located at http://www.celestiamotherlode.net.  
	To see them, you must first download and place them into the extras directory, then launch Celestia. 
	There is no toggle for Nebula labels. They must be turned on via the Render label menu.	     					   Figure 9 – Eagle Nebula

Stars	{B}  -  Displays a sky full of stars.  Obviously a key part of the Celestia experience.  Normally selected (no keyboard shortcut).  The {B} key toggles star labels on or off. 
The default version of Celestia 1.6.0 displays approximately 150,000 stars from the Hipparcos Catalog, with accurate information.  However, star datasets exist that draw 1 - 2 million stars.  They can be downloaded from the Celestia Motherlode addon website.  


Planets	{P}  - Displays all planets and dwarf planets as full color detailed models with textures.  Most visuals are based on accurate satellite photos of the planets.  Normally selected (no keyboard shortcut).  The {P} key toggles planet labels on or off.  


Atmospheres 	[Ctrl+A] is the keyboard shortcut to turn Atmospheres on or off (toggle) - Celestia will draw colored atmospheres above all planets and moons that have them.  You will be able to see them from space and even fly through them.  As you do, the sky will lighten.  Atmospheres display correct light scattering and haze.  The atmosphere will dim and turn color as you near the terminator (near the dark side).  It will also cast a colored planet-shine on satellites and moons in its vicinity.
	Figure 10 – Click here to visit				          Figure 11- click here to visit
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	Earth with Atmospheres selected.	   				  Earth without atmosphere
Clouds	[ I ]  Some of the planets in our Solar System and many fictional planets that Celestia users create in other solar systems have clouds drifting across their surfaces.  Celestia is one of the only space simulation programs capable of displaying clouds and putting them in motion.  In fact, cloud shadows cast on the ground are a feature of Celestia 1.6.0 (see next section).  On occasion, it is useful to temporarily deselect clouds, so you can see more surface detail.  Celestia add-on designers are also using the cloud texture layer to add new overlay textures to Celestia in addition to clouds.   The [I] key toggles clouds on or off. 
[image: ][image: ]	Figure 12 – click here to visit				Figure 13 - click here to visit













Cloud Shadows	(no keyboard shortcut) - is the ability to compute where on a planet a shadow would fall from a cloud overhead, and draw that shadow.  As the clouds move, so does the shadow across the ground.  It adds to the realism of the scenes, particularly on Earth.  

	Note that cloud shadows do not do well with all planets with clouds.  Jupiter, for example, is covered in clouds and when cloud shadows are active, the entire planet takes on a dark gray tone, making the planet look unnatural.  Currently, we recommend using cloud shadows ONLY with Earth, and perhaps a few other fictional earth-like planets created by add-on designers.   




Ring Shadows	(no keyboard shortcut) - Celestia can continually draw the position of shadows that a planet’s ring casts on a planet and conversely, the shadow a planet will cast on its rings.  The effect is dynamic and elegant.

Figure 14  – Ring Shadows enabled – click here to visit	    Figure 15 – Ring Shadows disabled =click here to visit
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Eclipse Shadows	[ Ctrl + E ]  Celestia can compute the actual position of the shadows a moon or planet will cast on a planet/moon as the object passes in front of the Sun (a solar eclipse).  Turning this feature on will cause shadows to be drawn on all planets/moons whenever an eclipse occurs.  It is an elegant feature, particularly when observing multiple moon shadows drifting across the giant gas worlds of Jupiter and Saturn.  
	        Figure 16 – click here to visit				     Figure 17 – click here to visit
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	Io eclipsing Jupiter, an example of Eclipse Shadows. 	          A total solar eclipse over Africa, as seen from space



Night Side Lights	[Ctrl + L] Celestia has the ability to light up the night sky.  From space, the thousands of cities across our continents are ablaze with light so bright that they can be seen vividly from hundreds of km up.  Turning on this option commands Celestia to add lights to the nighttime vista seen from space above Earth.  Night textures are also used in add-ons to show fictional cities or volcanic lava flows at night and even glowing aurora.  

	Figure 18 = click here to visit				      Figure 19 – click here to visit
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   Earth, Sun and terminator with night-lights enabled	         		Jupiter’s moon Io and its glowing volcanoes

[image: ]
Comet Tails	[ Ctrl + T ]  When closer to the Sun than the orbit of Jupiter (about 5 - 6 au or closer), Celestia will accurately place a gaseous comet tail behind all comets, properly sized and oriented to always point away from the Sun.  When a comet is far out in space far from solar heat, no tail will be displayed.  
		Figure 20 -Venus and comet Ikaya-Zhang in 2002
					 	                 						     		    Click here to visit

Celestial Grid	[ ; ]  Celestia places an equatorial coordinate grid on the screen showing you the celestial position and direction you are facing in space.  The grid follows the standard convention of Right Ascension and Declination used in Astronomy.  
[image: ]
For example, you can turn the grid on temporarily to identify direction of an object in Celestia then go to a real telescope and swing to that approximate coordinate.  You can also use the Celestial Grid to help you decide where to place a fictional add-on or to locate an object whose RA and DEC you know from another source (click the image)

      Figure 21	




Horizontal Grid	[ no shortcut ]  Celestia 1.6.0 now draws a coordinate grid on the screen that is horizontal to a planet equator, and perpendicular to its pole.  The gird will be drawn for any planet, moon or spacecraft.    
Figure 22- click here.  
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Galactic Grid	[ no shortcut ]  Celestia 1.6.0 draws a coordinate grid that is horizontal to the plane of the Milky Way.    
Figure 23- click here.  
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Ecliptic Grid	[ no shortcut ]  Celestia 1.6.0 draws a coordinate grid with its equator in the plane of the Solar System ecliptic and centered on the Sun
    
Figure 24- click here.  
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Orbits	[O] Celestia will draw the actual path a space object takes to orbit another body.  The orbit drawn will be based upon the orbital parameters used in the large database Celestia references to draw space objects.  Selecting the option will draw the orbits of all binary Stars, Planets, Dwarf planets, Moons, Minor Moons, Asteroids, Comets, and Spacecraft that you choose.  To select what orbit type you wish, check the box(s) of your choice in the 2nd menu in the View Options menu box.  

	Each orbit type is drawn in a different color.  Currently, planets and dwarf planets are both drawn with blue orbits, but a future version of Celestia will give dwarf planet orbits a different color.  When you select an object, its orbit turns to red.  For example, if you are centered on Venus and have “planet” orbits selected, Venus’s orbit will be highlighted in red.  All other planet orbits will be highlighted in blue.  

	Orbits are excellent for seeing the celestial mechanics of the solar system.  Turn them on, zoom out from the Sun or planet and view the orbits from above.  Speed up time (see later discussion) and you will see the alignment of planets speeding around the Sun, or view the orbits of satellites as they circle around a planet.  The Orbit/Label section of the View Options Menu allows you to turn specific orbit types on or off with a check mark in the box.   

[image: ]

		   	Figure 25 - click here to visit

Our “new” Solar System with planet and dwarf planet orbits enabled and time speeded up.  The inclined orbits are those of Pluto, Ceres, Eris, Makemake and Haumea, our five “dwarf planets”.  Press the [8] key to select Neptune.  The orbit will turn red.








Markers	[Ctrl + K] and [Ctrl + P] - When enabled by pressing the [Ctrl+K] keys, Celestia will draw small markers around any object (star, galaxy, planet, moon, spacecraft, etc.) you select and mark.  To mark an object, simply select it with a single or double click of the left mouse button so that its name appears in the upper left corner.  Then, turn on Markers with [Ctrl + K].  Red markers will appear around the object.  If you select another object, the red markers will jump to the next object.
	 Sometimes, you would like an object to stay marked.  For example, perhaps you would like to track a spacecraft anywhere it goes through space, even if you click on another object.  To more permanently “Mark” an object, select it, right-click on it and choose “Mark”, or press [Ctrl+P] from the keyboard.  A green box will appear on the object and will stay there until you turn off Markers.  You can mark as many objects as you like.  
	To unmark an object, right-click on it to select it and choose “Unmark”, or press [Ctrl+P] again.  To turn off all Marks, press [Ctrl+K] again.  Marks are very useful for tracking an object in space that you’ve lost sight of, or for highlighting objects so that you can find them easily again.  For example, you can mark the Voyager 2 spacecraft as it speeds alone out of the Solar System.  No matter where you travel in space, you can always see it by scrolling to locate its green marker.  

	Note:  All Marks are erased and reset to off when the program closes.


Orbits/ Labels and DSO Labels    The lower region in the View Options menu provides you checkboxes to turn on or off various labels for planets, stars, moons, spacecraft, comets, etc., and for deep space objects (DSO) such as galaxies, nebula, globulars and open clusters.  You can also select which orbit paths you want Celestia to draw, when applicable.  Checking or unchecking the boxes is self-evident.
	Labels and Orbits for far objects are not displayed until you get closer to them.  For example, there are hundreds of thousands of stars and 10,000 galaxies in the Celestia sky.  If labels were enabled for all of them, the sky would become filled with text.  Only when you approach an object (star, galaxy, planet, etc.) will its label and orbit lines turn on.  

Labels keyboard shortcuts are: 
 P		Toggle (turns on or off) planet labels
Shift+P		Toggle dwarf planet labels
M		Toggle moon labels
Shift+M	Toggle minor moons
E		Toggle galaxy and nebula labels
Shift+E	Toggle globular cluster and open cluster labels
B   		Toggle star labels
W		Toggle asteroid labels
Shift+W	Toggle comet labels
N   		Toggle spacecraft labels
=   		Toggle constellation labels
Shift + &	Toggle Location labels
Ctrl + K	Toggle Markers
Ctrl + P	Set a Marker
V   		Toggle info text 



Information Text 	[V] - This box allows you to choose how much data you want displayed when you select an object.  Pressing the [V] key also toggles the information display on or off through two levels of detail.  If you see no text at all on the screen, press [V] to turn it on.


[image: ]Constellations	[Ctrl + B]  [ / ]   [ = ].  In the right Options menu, you can turn on constellation diagrams (asterisms), boundaries, labels and Latin names for each of the 88 constellations in the sky.  These options are useful whenever you wish to locate a constellation and study info about it.  The above keys toggle each feature on or off.


					

Figure 26 - Constellations with all options enabled.  As viewed from Earth, the Sun is “in” Capricorn.  


																	Click here to visit.



Filter Stars 	This slider determines how many stars Celestia will draw at one time.  It regulates star number by how far away a star is from your viewpoint.  By default, it is set at 1,000,000 light years.  Since the diameter of our galaxy (the Milky Way) is about 100,000 LY across, Celestia will draw all stars in its database at this slider setting.  However, you can lower the slider and command Celestia to draw only closer stars.  For example, if you set the slider to 100, the program will only draw stars within 100 light years of Earth.  Since this requires far less computing power than the highest slider value, this may be useful if the program is running slowly for you.  Lowering the slider will speed things up.  Also, you may have a scientific need to only see the closest stars to your viewpoint.  Obviously, however, the sky will look a bit empty if you filter out too many stars. 



Locations     [Shift + &]   A separate menu in the main Render menu in Celestia is a feature that directs the program to mark and label any city, observatory, landing site, mountains, seas, craters, valleys, land masses or other features you desire on a planet or moon, and display its name above its latitude and longitudinal position.  To enable this feature, press the [Shift+&] keys.  Celestia 1.6.0 comes with an excellent default list of locations when it is installed onto your computer.  To toggle the list of features on or off, use the menu checkboxes in the Render sub-menu.  

Celestia users continue to develop new locations files.  These include Earth volcanoes, tectonic plate boundaries, telescopes, highest mountains, political boundaries, etc.  Some are available at http://www.shatters.net/~claurel/celestia/files/locations/ and at the Celestia add-on repository site at http://www.celestiamotherlode.net/index.html.   The Celestia forum also contains links to many locations files.  
	To use a Locations list, locate and download a list file from the web and place it in your “extras” folder in the main Celestia folder in/on your computer.  It will then display when the Locations option is enabled.  NOTE:  When observing an object from far away, only the largest or most important locations are shown.  As you approach it, more labels will appear.  To change the distance at which particular labels first appear, move the slider in the Minimum Labeled Feature Size panel in the Locations sub-menu.  

Markers are also applied to locations and can be turned on or off from the Locations Render menu.  To mark a location, simply select it by name (see below), then press [Ctrl+K] to turn on Markers.

Locations may be manually selected by entering their names (see :  Selecting Objects by Enter/Name/Enter Method section below).  Generally, you must enter the name of the planet or moon where the location is found, as well as the location itself.  For example, to locate and go to Cairo, press the [Enter] key and a sub-screen will appear in Celestia with a place to type an entry.  Type 'Earth/Cairo' (or 'Sol/Earth/Cairo' if you are outside the Solar System.), then press [Enter] again and the [G] key to go there.  You will be taken by the program to a position located directly above Cairo.  Note that if the location is on the opposite side of a planet from where you are, Celestia will take a shortcut through the planet and stop above the location you select, but facing into space.  You will have to rotate your view to see the location (see later sections for how to rotate your view).  



Stars Visible – { [ } or { ] }  - On the Render menu, select “More or Fewer stars visible”, or toggle with the keyboard shortcuts.  Like the Filter slider discussed earlier, this tells Celestia how many stars to draw in the sky at one time.  However, it controls star numbers by Apparent Magnitude (visible brightness).  On the surface of Earth, our view generally includes stars of an apparent magnitude of +6.0 or less (the lower the number, the brighter the star).  Setting this option to Magnitude 6.0 results is a realistic sky as seen from the surface of Earth on a clear night, with only about 3,000 stars visible.  However, if you were living on a space station far above earth’s atmosphere, you might see stars up to a magnitude of +8.0 or more with the naked eye.  Because there are more stars in the sky, many Celestia users prefer higher star settings of +8.0 to +10.0.  The keyboard shortcuts are very useful here.  Experiment by using the keyboard key “[“ to decrease limiting magnitude (fewer stars visible), and “]” to increase limiting magnitude (more stars visible).  Note that by turning stars on or off, you are changing the amount of data Celestia must process each second.  If you are experiencing slow performance, reduce star count.
		            Figure 28 						    Figure 29 
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   	         Stars at Magnitude setting of 7.5		      	   Same scene at Magnitude setting of 15.0.	   




AutoMag - [Ctrl+Y] - The default download of Celestia actually contains about 100,000 stars up to magnitude 15.0 visible from the vicinity of Earth.  A setting of 10.0 or more simulates the view you would see through a telescope.  However, millions of stars have been cataloged by Astronomers and if you wish, you can download a star database from the Celestia add-on repository that contains over 2,100,000 stars.  You can find it and a 1 million star database here.  
	To use the bigger star file, you have to change its name to “stars.dat”, and place it inside the data folder in Celestia (move the original stars.dat file already in that folder to another safe place first).  Then launch Celestia.  If either of the larger star files are loaded, and you select the maximum magnitude limit of 15.0, the sky will be ablaze with stars.  Note that this level of star display can slow down many computers.  The choice is yours.  
	Fortunately, Celestia helps you to set realistic star magnitudes with a feature known as AutoMag.  To enable AutoMag, select it from the Render menu or press the [Ctrl+Y] keys.  To disable it, press them again.  When AutoMag is enabled, Celestia will display stars automatically within a set range of magnitudes to maintain a reasonable visual range whenever you change your field of view (FOV).  For example, if you zoom your view with the FOV key controls, it will automatically add dimmer stars to keep your star count constant.  It will also restrict your view to a magnitude range of 6.0 – 12.0.  A screen display will advise you of your changes. AutoMag is very useful if you change the FOV by zooming in or out.  We recommend you leave it activated.
	AutoMag also controls galaxy brightness.  As you approach or leave a galaxy, its brightness will change to mimic what your eyes would see in deep space.


Star Style -	[Ctrl+S]  Celestia can display stars either as fuzzy points, points, or scaled discs.  Which looks better is a matter of personal taste and the resolution of your monitor.  In general, a scaled disc forms a prominent circular disc that varies in both diameter and brightness based upon the actual size, magnitude and distance of the star from you.  For example, a bright Red Giant star nearer Earth will be a larger reddish disc in the sky with this option enabled, while a smaller main sequence yellow star will appear smaller and dimmer in size.  Scaled discs are not designed to mimic the true visual appearance of the sky.  Instead, they enable you to locate stars by type and magnitude.  
	Fuzzy points take a similar approach but draw a smaller, more realistic “point” that varies in size and brightness.  This choice is particularly good when using LCD Projectors and monitors, since Fuzzy Points are larger and brighter than points, and easier to see on an LCD screens.   
	Stars displayed as Points draw stars as points of light of varying brightness.  It is the preferred choice of some users who use high-res monitors and older CRT monitors.  Selecting Points may also make Celestia run faster.  However, since the points are dimmer and smaller, your viewing room should be dark when using them.
	You can cycle between the three star styles with [Ctrl+S] or you can set the style by using the Star Style sub-menu on the Render Menu.  

[image: ]           Figure 30  - click here to visit		        Figure 31				Figure 32
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	      Scaled Discs enabled
     Fuzzy Points enabled
           Points enabled



Stars by temperature -  [ Shift + % ]  Controlled by keyboard command, this control toggles the appearance of stars to highlight/accentuate their spectral class colors.  For example, “M” stars are reddish.  When [Shift+%] is pressed, all the M stars in the scene will be more red.  All the “O” (blue stars) will be more blue, etc.  It helps you visually locate stars of a particular spectral class.  


Ambient Light -  [ Shift + {  ] or [ Shift +  } ]  - On the “Render” menu, select “Ambient Light”.  Since space is a near vacuum, there is very little light scattered and shadows are completely black.  You can set the ambient light level to “none” to simulate this and get the most realistic views of space.  We recommend this be your default setting.  However, there are times when a bit of extra light is useful or aesthetically pleasing.  For example, go to the dark side of any planet and adjust ambient light from None to Low, then to Medium.  You’ll discover that portions of a planet’s dark side become visible with some light scattering.  Having a bit of extra light is also good for seeing spacecraft.  When they’re on a planet’s dark side, they almost disappear in the shadows.  Low or medium light allows you to track them better.  Use keyboard shortcuts [Shift + {] to decrease ambient light and [Shift + }]  to increase it through 20 step levels.    
	
	Figure 33 – click here to visit				                       Figure 34
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     Pluto and its moon Charon with Ambient Light set to None	            Same scene with Ambient Light set to Low.	   
	

Antialiasing -  [ Ctrl+X ] -  On the Render menu, select “Antialiasing”.  These are instructions to Celestia to use certain graphical processing and smoothing techniques when it draws lines on the viewscreen.  In general, Antialiasing evens out the lines used to draw sharp edges of spacecraft, orbit paths and constellation figures.  We recommend you keep it on.
	


Wire Frame mode -  [ Ctrl+W ] -  pressing these two keys will convert the object you are looking at, into a wire frame mesh model.  This feature is useful for model designers of spacecraft, planets, moons, etc.
	
Note:  Keyboard shortcuts for turning on and off (toggling) the options and features described above, along with other keyboard shortcuts, are listed in printable format at the end of this document." 



Right-Click Object Menu

32) When Celestia is running and you [right-click] on an object such as a star, planet, moon, spacecraft, asteroid or comet, a set of menu features will be available.  What these features do is listed below:
33) GoTo, Follow and Sync Orbit (see Navigation section on the following pages)

34) Info  	Celestia contains hyperlinks to several reference websites.  Selecting “Info” from the [right-click] menu will take you to the appropriate site and display additional information.  For example, Celestia links to the website “nineplanets.org” for further information about the planets in our system.  Note that not all objects have Info sites.  This is particularly true for spacecraft and for addons created by other volunteers.      

35) Reference Vectors – provide arrows and grids that help you identify the orientation of the object in space.  Celestia will remember these settings and launch the program with them active the next time.  Specifically:   
a) [image: ]Show Body Axis – displays three arrows, representing the X, Y and Z coordinate directions of the object.  The Z comes out the north pole.  The X axis issues from the position of the vernal equinox at the J2000 epoch in the mean equatorial plane (e.g. - the zero degree line of longitude at the equator), and the Y axis come out of the equator at a 90o angle to that.
  

b) Show Frame Axis – displays three X, Y and Z arrows similar to the above, but the arrows are oriented to the internal body frame of the object, providing a reference to developers and model makers in orienting their models in Celestia.  

c) Show sun direction	 – 	points an arrow at the sun
d) Show Velocity Vector – 	points a vector arrow in the direction the object is moving on its orbit 
e) Show Planetographic Grid – places a labeled spherical coordinate grid on the object (planet, moon, spacecraft, asteroid or comet)   Note:  Does not place a grid on stars
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f) [image: ]Show Terminator –  places a yellow line on the approximate location of the sun’s terminator (junction of light and dark).  This can be useful when considering the seasons, since the terminator changes over the course of the year.  On the equinoxes, it passes directly through the poles. 


36) Satellites - 	If an object has man-made satellites or moons orbiting it, and they are identified as such in their internal orbit code files (called ssc files), they will be displayed here.  Select one and press the [G] key to go to it, or press the [C], [F], [Y] or [T] keys to center it, follow it, sync orbit it or track it.  Note that not all man-made objects are given a satellite designation.  It is up to the designer of the object.  If an object placed in orbit around another object is not specifically given a “satellite” designation, Celestia assumes it is a moon, and considers it as such in the [right-click] menu.

37) [image: ]Alternate Surfaces -    Celestia comes with a moderate collection of textures that the program uses to draw the surfaces of planets, moons, asteroids, spacecraft, etc.  Celestia takes great care to include textures that are true and complete or partial photographs of the planet or moon.  In that way, the program’s images are impressively accurate.  However, add-ons developed by forum members are available for download from various websites that define Alternate Surface maps for many space objects.  For example, you can command Celestia to load an image of the Earth as it may have looked 4 billion years ago, soon after it formed.  Its surface will be covered with craters and lava flows.  Another Alternate Surface available for Earth is this latitude and longitude grid that overlays a map of the equator, prime meridian, Tropics of Cancer and Capricorn, etc. onto a modern image of the planet.  A third popular Alternate texture is of Earth at the time of the Ice Ages.  See the planet covered in ice, and the extent of the ice sheet boundaries.  Alternate surfaces are also often used for global maps of temperature, elevation, topographic or other geographical/educational data.
Only one Alternate surface is displayed at a time.  If an Alternate Surface is available (has been installed in your Celestia extras folders) it will appear in the menu that is displayed.  Simply click on its name and Celestia will load and draw the Alternative texture.  To return to the original “normal” texture, you MUST right-click on the object again, choose “Alternate Surfaces” and select the “Normal” texture.

Alternate Textures are add-ons.  They must be downloaded and installed into your extras folder in Celestia.  Many can be found on the Celestia Motherlode website at http://www.celestiamotherlode.net/.  The Alternate texture above can be found at:  http://www.celestiamotherlode.net/catalog/show_addon_details.php?addon_id=1012.

38) Limit of Knowledge Textures [Shift and +] key - The surfaces of some of the bodies in our Solar System have only been mapped or photographed incompletely.  By default, Celestia uses surface maps that have the unknown regions filled in with plausible surface features, typically cloned from some part of the body that has been imaged.  But Celestia also includes a set of maps called 'limit of knowledge textures' (LOK) that depict the unknown areas as blank, clearly showing where our spacecraft have and have not aimed their cameras.  The [Shift +] key toggles between the default 'interpretive' maps and the limit of knowledge textures, if they are available in Celestia’s files.  
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Figure 40 – Mercury with surface filled in 	    click here to visit	    Figure 41 - True Limit of Knowledge


Lua Edu Tools     

39) Lua Education Tools/overlays [Shift + I] – In 2007, a gifted programmer named Vincent Giangiulio added an exciting new feature to Celestia.  Known as Lua Edu Tools, it is available as an add-on from this location:
http://gvince.perso.sfr.fr/celestia/lua/Lua_Edu_Tools_1.2beta8.zip, or on the Celestia Motherlode website at:  http://www.celestiamotherlode.net/creators/v_giangiulio/Lua_Edu_Tools_1.2beta7.zip" http://www.celestiamotherlode.net/creators/v_giangiulio/Lua_Edu_Tools_1.2beta7.zip
	Download and install it in your extras folder.  Read the enclosed “Read-me” file for further instructions.  
[image: ]	Lua Edu Tools are designed as educational tools, both in schools and at home.  They provide a large set of features and commands to Celestia.  When Celestia is launched with the feature active, the program will open with a text “toolkit” displayed on the right side of the screen.  The kit includes on-screen sliders and menus to control many of Celestia’s parameters, latitude and longitude readouts, a compass overlay (when close to a planet), new coordinate grids, a “Distance” projection and access to a growing set of addons. Using the “set addon visibility” menu, a user can select from over 20 addons developed specifically for use with Lua Edu Tools, toggling them on or off while the program is running.  For example, one addon toggles all of the world’s major cities.  Another turns on an outline of the coastlines of Earth.  A 3rd activates the names of Earth’s major oceans and seas.  A fourth addon takes you to the center of the Milky Way to see a massive Black Hole.   
There is even a “Cockpit” overlay that simulates the instrument panel of the NASA space shuttle, looking out its front window. Another overlay displays a listing of Celestia’s complete set of keyboard controls. There are several texture overlays available, plus additional info and image displays.  Recently added is an expandable Lua Edu Tools addon that provides dozens of photos about the specific object you are viewing.  
When Lua Edu Tools is active, press [Shift + c] to toggle the Cockpit overlay on or off.  Press [Shift + I] to toggle Lua Edu Tools on or off.
An addon pack for Lua Edu Tools is available that contains 19 separate addons for Lua Edu Tools, including those mentioned above.  It can be downloaded free from http://www.celestiamotherlode.net/creators/fsgregs/Lua_Edu_Tools_Addons_v1.zip" http://www.celestiamotherlode.net/creators/fsgregs/Lua_Edu_Tools_Addons_v1.zip
 

Sound     

40) In 2006, volunteer programmers working with Celestia inserted code in the program to play up to eight sound files (WAV files) from inside Celestia.  As of this printing, the official Celestia program version 1.6.0 does not have this feature integrated in Celestia.  However, Vincent Giangiulio recently reported that a 3rd party set of code dll files called proteaAudio, can be added to the Celestia main directory and by so doing, sound will play from within Celestia, in wav and ogg/vorbis formats.  Reportedly, the sound can even be in surround format. For more details, see this forum thread:  http://www.shatters.net/forum/viewtopic.php?f=15&t=14366&hilit=sound 
41) In addition, a customized educational version of Celestia 1.6.0, called Celestia160-ED, is available as a free download.  It does contain internal code to play up to 8 wav sound files.  It is available at http://celestiamotherlode.net/catalog/educational.php
Sound in either the Celestia 160-ED application or the Celestia 1.6.0 application with proteaAudio installed, is controlled from a script file, which is a separate file written by Celestia volunteers containing written code commands that Celestia can understand.  When the script is loaded (see later section for how to load scripts), certain sound files will play or become available, based upon internal commands in the script or keystroke commands.  The files can include music, narration and sound effects.  Press a key and one of the eight sounds will begin playing.  Read-me files that accompany the scripts will explain what keys to press, and when.
The Celestia forum has more information on how to create and use sound scripts.  Look for them on the Motherlode website under the “Scripts” section located at: http://celestiamotherlode.net/catalog/scripts.php" http://celestiamotherlode.net/catalog/scripts.php



Movement

42) General movement in Celestia is one of the highlights of this amazing program.  It is easy and versatile.  Movement keys are very important for enjoying the Celestia universe.  For example, if you wish to go into an orbit hovering above a planet, drop down to its surface or fly in your spaceship to the edge of the Milky Way, you will need to change direction, orientation and distance in space frequently.  There are 16 keyboard or mouse general movement commands.  You do need to memorize or become very familiar with them.  Let’s return to our opening scene of the Earth (to do so, click here ).

A. Right-click on the scene in front of you and while holding down the right mouse button, move your mouse [Right-click-drag].  Earth will rotate left, right, up or down.  You can view it from any perspective you wish.  This control is used constantly in Celestia.  
B. Left-click your mouse and while holding the button down, drag the mouse.  The whole scene will shift as a whole [Left-click-drag]
C. Tap the [down â arrow] on the keypad, or the [# 2] on numeric keypad.  Your view of Earth will pitch upward.  Before you use the numeric keypad, make sure you press the key labeled “Num Lock” at the top of the numeric keypad.  If so, there should be a little light lit up above the numbers on your keyboard
D. Tap the [up á arrow] on the keypad or [# 8] on numeric keypad.  Your view will pitch downward
E. Tap the [left ß arrow] on keypad or [# 7] on numeric keypad.  Your view will rotate (roll) clockwise
F. Tap the [right à arrow] on keypad or [# 9] on numeric keypad.  Your view will roll counter-clockwise
G. Tap the [#ß4] key on the numeric keypad of the keyboard.  The view will swing (yaw) to the left
H. Tap the [# 6à] key on the numeric keypad.  The view will swing (yaw) to the right as a whole
I. Tap the [# 5] key on the numeric keypad to stop all pitch, roll and yaw movement
J. Hold down the [Shift] key and press one of the [Arrow] keys (e.g.  [ Shift+à ].  You will “orbit” around the object in view, either left/right, or up/down.  This is convenient to see all of an object quickly

Note.  The speed with which the view turns when you press the above keys is initially set at a particular value (120) in one of the files that Celestia uses to operate.  That file is called celestia.cfg, and can be found in the main (root) directory of the Celestia folder.  If you find that your view is turning too fast or too slowly for your taste when you press a movement key, that file can be opened by you and the Rotate Acceleration (turning speed) of the above keys can be lowered or increased.  To do so, double-click on the file.  If a menu comes up asking you which program you wish to use to open the document, choose “WordPad” (for Windows systems) or the proper plain text editor for MAC and Linux systems.  When open, locate the line “RotateAcceleration 120” and change the number either higher (to turn even faster) or lower (to turn more slowly).  For example, RotateAcceleration 40 will result in your view turning more slowly when you hit a movement key.  Many users prefer the increased control it gives them, particularly if they use the Celestia spaceship.  
You will also find that a variety of other commands in the celestia.cfg file can be changed by you to alter the way Celestia does things.  Read the document’s directions and make any changes you wish.  After changing, save the change by clicking the File and SAVE menu choices, and close the document, then relaunch Celestia.  

K. [Right-Click + Left-Click + Drag] – (press all together) - your position will advance toward or recede away from the object.
L. [Ctrl + left + Drag] – same as (k) above
M. [Roll Center Mouse Wheel] (if you have one) forward or backward – same as (k) above
N. Press the [Home] key on the keyboard.  This is the same as (k) but using the keyboard only.  Your position above any object will rapidly approach toward you.  
O. Press the [End] key on the keyboard.  This is the same as (k) but using the keyboard only.  Your position above any object will rapidly recede away.  Hold down the key and you can move light years away.
P. Press the [ Shift + * ] on the keyboard.  This is a Lookback command.  It will reverse your view so that instead of looking forward, you will look behind you (a rearview window).  It is very stimulating when flying from one planet to another or traveling in your spaceship.  You can see forward and then examine your journey from the rear view, watching the planet or moon you just left recede from you.  Make sure you press the two keys again, however, to look forward again.


 Joystick Control   [F8]
43) You can also control your movement via a joystick (Windows only).  The commands for joystick control of Celestia are listed in the back of this document, in the Keyboard and Mouse Command Summary.  Press the [F8] key to turn Joystick control on or off.


 Selecting Objects (general)
44) In Celestia, you will usually have some object selected.  If so, the program will list its name in the upper left corner.  It can be a star, planet, dwarf planet, moon, asteroid, comet, spacecraft, galaxy, nebula, misc. object or location.  The simplest way to select most objects is to point at it with your mouse and [left-click] on it.  Return to Celestia and try clicking once on a star to select it.  The information display changes to details about the star.  Note that you have not actually gone there or changed anything yet.  You’ve just told Celestia that you have selected a new object (if you see no text on the screen, type the [V] key on the keyboard.)   

45) To go to the star you just selected, you have four main ways to make the journey (practice doing all four):  

A)  If you right-click on the selected star, and select “Goto”, Celestia will take you at hyper-light speed directly to that star and position you in space at a convenient distance.  
B)  Alternately, you can press the letter [G] on the keyboard.  That is the shortcut command for “Goto”, and is used extensively in Celestia.   
C)  You can select the star and fly to it in your spaceship.  It takes longer but sometimes the journey is half the fun of getting there.  How to operate your spaceship is explained later below.
D)  You can also select an object using keyboard commands, then use the advance [Home] key, or recede [End] key or your [center mouse wheel] to get there.  To do so, simply point at a star or planet, left-click on it with the mouse so that it is selected and tap both the [C] and the [F] keys on the keyboard.  The [C] key tells Celestia to center a selected object in the middle of your viewscreen.  [Double-clicking] quickly on an object will also center it.  The [F] key tells Celestia to follow the selected object, keeping it the same distance from you even though it is moving through space.  
	Let’s try it!.  Point at a star, left-click on it to select it, and tap the [C] key.  It will swing and become centered.  Then press the [F] key.  The words “Follow (star’s name) ” will appear in the lower right of the screen.  Now that you are following that object, go to it by holding down the advance [Home] key.  When you get there, back away from the object using the recede [End] key.  You can also roll your [mouse wheel].  
46) Go to Surface [Ctrl + G] – If you are following an object, pressing this key combination will take you directly to the surface, looking at the horizon.  Although it will work for all space objects, it is designed for planetary bodies, moons, etc.  The direction you are looking at after the execution of this command, will be the direction of the body that was pointing up on your screen before you gave the command.

47) GO HOME  [H]  - To return to our Solar System from anywhere in the universe (a very useful thing), press the [H] key on the keyboard.  That will select “Sol” (the Sun).  Tap the [G] key and you will be whisked back to our Sun.  Note: You will use these two keystrokes constantly as you explore the Celestia universe and wish to return home.  
    
48) To cancel a current selection, hit the [Backspace] key once on the keyboard.  To cancel a navigation command such as Follow or Center, press the [Esc] key in the upper left of your keyboard.  You will now be adrift in space.  Objects will still be selected and you can return to going to them, following them or tracking them, etc. by simply hitting the [G] or [F] keys again.    

49) Note:  Pressing the [Esc] key will not only cancel a navigation command, it will also cancel any scripts that are running.  If you are running a script, this may not be what you wanted to do.

50) [Right-Click]:  There is another way to select objects and is one you will use often.  To demonstrate it, click here.  You will be taken to a position above the planet, Jupiter.  [Right-click] on Jupiter to bring up a menu of options.  One of them is “Satellites”.  Choose it and a list of Jupiter’s moons will appear.  Left-click on any one of them and press the [G] key to travel to it.  You can use the right-click feature when the object you visit orbits a star or planet directly.  If there is no “Satellites” option in the menu that appears with a right-click, that means the planet or moon has nothing else orbiting it.

All of these keyboard key shortcuts are again summarized in the handy list at the end of this document.  


Navigation Menu

51) Celestia has a complete menu at the top of the program dedicated to space navigation that you can use often.  Some of the choices are single commands (e.g. – Select Sol).  Others open dialog boxes that give you some choices to make, or ask for some input.  Most of the menu choices have convenient keyboard shortcuts.  Pull down the Navigation menu and you will see …
  

Select Sol   [H]
52) The Navigation Select Sol menu item directs Celestia to “select” our Sun (its Latin name is Sol).  You can select and locate it in space from anywhere, even from far outside of our solar system.  It is very useful to do when you are far from home and simply want to return to our solar system.  The keyboard shortcut for selecting Sol is [H].  Please note that all you have done is select the Sun.  You have not gone there or even centered it in your viewscreen.  To do that, you must enter a 2nd command, as described later below.

Tour Guide 
53) The tour guide opens a pulldown list of a few of the more interesting objects you can visit in Celestia.  Select the “Tour guide” option in the Navigation menu to bring up the guide window, choose a destination by clicking on the pulldown arrow and select from the list, click the “Go To” button, and click OK to close the window.  You're off.  We urge you to visit some of these stops on the tour.  NOTE:  As you become more experienced with Celestia, you can edit this file in your Directory and add your own tour stops.

Select Object 
54) The Select Object option opens a dialog that enables you to type the name of an object you wish to visit and then go there.  Select this option and in the space provided, type “Polaris” and click OK.  Now, hit the [G] key and you will zoom to an orbit above the North Star.  Try another space object.  Please note that if the object is not a primary space object such as a star or galaxy, you must get closer to it before this menu will work.  For example, if you are outside of our solar system in distant space, opening this menu and typing “Earth” will not work.  You must first type “Sol” and go there (Sol is a primary space object).  Once within our solar system, then typing Earth will select it.  Also note that this option also works for Locations.  

Goto Object 
55) Choosing this option from the Navigation menu opens the "Go to Object" dialog box.  There are two uses for it.  First, it can be used to find your exact position in relationship to objects you may already have selected.  For example, if an object (such as the Moon) is already selected when you choose this option, the information fields you see in the Dialog box will contain your current position in relationship to the Moon.  This will include the object’s name, and your Latitude, Longitude and Distance directly above its surface (center of screen).  This is very useful when you are positioned above something and you want to know exactly where that spot is.  If no object is selected, the fields will be blank.  

56) You can instead, change the values and go somewhere else.  For example, in the box, type Mars, enter 30 for the latitude, 5 for the longitude and 5000 (km) for distance.  Click “GoTo”.  You will be taken to a position 5,000 km above the surface of Mars, at 30° N latitude and 5° E Longitude.  You will automatically be placed in “Sync orbit” around the object, meaning that as it turns, you will turn with it so you are always above the spot you desire.  This is an excellent way to position yourself for eclipse events or above craters, etc.  Please note, however, that when you arrive, you may be on the dark side of a planet.  In that case, you may have to reset the clock to a time when daylight is shining on your position (see later discussion), or you can move your position to a different longitude.  If you move your position by dragging on the screen, the positions in the GoTo Object box will automatically change to reflect your new position (close and reopen the box).

57) Note that Longitudes are + values for positions East of (0°E) and negative (-) for longitudes West of (0°E).  For example, longitude -40 would be 40° W.  “Distance” is distance to the surface of the object.

Center Selection   [C] or  [Shift+C]
58) This command will direct Celestia to reposition any object previously selected in the center of your viewscreen.  It is used very frequently in Celestia.  For example, if you select a star anywhere in the sky by left-clicking on it, you can center it by simply choosing this menu command in the Navigation menu, or pressing the [C] key on the keyboard.  Double-clicking on the object will also center it in your viewscreen.
  
59) If you were orbiting a planet or star when you selected and centered a new object, you might or might not lose sight of your original object as the viewscreen moves to center the new object.  To compensate for that possibility, Celestia provides the [Shift + C] key combination.  Pressing both of them together causes the viewscreen to swing to center the new object you selected, without losing sight of the original.  To test this out, click here.  You will be taken to a position behind the Moon, with the Earth off to the right.  Earth has been pre-selected, but is not yet centered.  To do so, press the [C] key.  The view will swing to the right and the Moon will move off screen to the left.  Return to your starting view by clicking the above link again, but this time, press the [Shift+C] keys together.  Earth will again center, but the Moon will still be fully visible.  Your view will take up position behind the Moon.  This feature is obviously useful if you do not want to lose sight of the original object as you sight and center on a new one.  It’s NEAT!

Go To  Selection   [G]
60) Previously mentioned, this command will direct Celestia to go directly to your selection, and position you a pre-calculated distance above it.  You can use it with any of the Selection options mentioned here or in the following paragraphs.  For example, if you select an object with a left mouse click, choosing this command from the Navigation menu, or pressing the [G] key as a shortcut will send you directly to the object you selected at high speed.  If you choose it again or press the [G] key again, you will move closer to the object.  [G] is used constantly in Celestia.

 Follow Selection   [F]
61) This menu and keyboard command will direct Celestia to lock onto the object selected and follow it.  As it moves through space on its orbit, you will move also.  The object can turn below you on its axis (if it is rotating) so the longitude will change constantly, but you will stay the same distance and latitude above it.  It is routinely used when you wish to take an orbit position in space above a star, planet, moon, asteroid or a spacecraft.  The keyboard shortcut for “Follow” is [F] and will be used very frequently.  To test out its use, click here.  You will be positioned above Mercury.  Watch as Mercury drifts slowly away.  Now press the [F] key.  It stops drifting and you are locked onto it, moving with it.

Sync Orbit Selection  [Y]
62) This feature lets you hover directly over the same position/spot above an object that you have selected.  For example, if you are above Earth with Africa below you, selecting Sync Orbit will tell Celestia to keep you positioned above Africa all the time.  As the Earth turns below, so will you.  To see that effect, click here.  Time has been sped up.  Many of our satellites (navigation, weather, spy, GPS, TV and radio) are in synchronous orbit around Earth.  You can use the command in fact, to hover above a particular satellite as it orbits its host planet or moon.  The keyboard shortcut for Sync Orbit is [Y].  

Track Selection  [T]
63) This command tells Celestia to track a selected object as it moves through space, keeping it centered in view.  The keyboard shortcut for Track Selection is [T].  For example, click here.  Celestia is tracking the asteroid Gaspra.  Watch it pass close by you.  It is dramatic!  

64) When Track is selected, you can zoom in or out with the [Home] or [End] keys, and/or [right-click and drag] the mouse and your tracking viewpoint will change.  For example, try right-click-drag of Gaspra so that it comes at you from another direction.  

Note:  Tracking will stay activated on a space object and your screen will remain pointed at it, even if you select another space object.  You must cancel tracking on the first object before you seek to view another object.  To cancel tracking, simply press the [T] key again.  Try it with Gaspra!

Also note that tracking cannot occur if you are already “Following” or in “Sync Orbit” around another object.  Before you can track that object, you must first release your hold on it by pressing the [Esc] key.  Then, press the [T] key to track it.    

Chase Selection  [“]
65) Although not in the Navigation Menu, this command is available by pressing the quotation [ “ ] key on the keyboard  [Shift + “].  It instructs Celestia to chase a selected object in space.  It is similar to the “Sync Orbit” command.

Lock Selection  [Shift + :]
66) Not available in the Navigation menu but available through a keystroke [Shift + :], the Lock command is used in conjunction with other commands to bind two separate celestial objects together in space.  For example, click here to select Phobos, one of the moons of Mars, and follow it.  Notice that Mars is slowly moving in its orbit.  Now, left-click once on Mars to select it, and press the [Shift + : ] keys.  The display in the lower right corner will now say, “Lock Phobos>Mars”.  The command will place you in a position that remains stationary above both objects, even as they move in space.  This command is also particularly useful for watching spacecraft orbiting around planets.  Go to and “follow” the spacecraft of your choice, then [left-click] on the planet below, press the [Shift + :] keystrokes and the spacecraft will be locked around the planet.  As it orbits, you will have sight of both of them.  .  
67) Note:  When interacting with an object, you can choose the Follow, Center, SyncOrbit, Track, Chase and Lock commands at any time.  Center and Track can be used alone or in combination with the other commands.  The others will execute only the last command given.  For example, if you are “Following” an object and press the Chase or Sync Orbit command, it will replace the Follow command.  If you type the [Esc] key, the current object will be released from all commands.  To “unlock” two objects, replace the lock command with another one such as the [F] command, or press the [Esc] key.  


Solar System Browser:
68) At the top of the screen, select the Navigation menu and choose Solar System Browser.  A complete list of all objects being tracked by Celestia in the local Solar System will appear.  Next to planets or moons may be a + sign, which indicates that around them are more objects to choose from.  Select any one of them and choose to either “Center” it, or “Go To” it.  Centering is useful when you want to see where an object is in space without going to it, or when you want to use your spaceship to journey to that planet, and you want to locate and center it first.  Go To is used when you just want to get there fast.  You should use this navigation menu frequently, since it is the complete list of all objects in the solar system, including all moons and spacecraft.  Try it.  Go to Neptune, Saturn, or one of their moons.  Please note that if you are in another star’s environment or solar system, its list of planets, moons and space objects will appear in the Browser instead.  Also please note that the default download of Celestia comes with only a few spacecraft.  However, over 50 other spacecraft are available as add-ons for our Solar System from the Celestia add-on repository and other sites, and will all appear here in the Solar System Browser list if you install them all in your files.  To get add-ons, see our prior discussion.


Star Browser:
69) Select the Navigation menu and choose “Star Browser”.  A list of a few hundred of the stars being tracked by Celestia will appear.  Clicking on the column headers at the top of the menu will sort the stars different ways. For example, if you click on the word, “Distance”, Celestia will sort the list of stars by distance from our Sun.  If instead you click on the column header titled “Type”, Celestia will sort the list according to the star’s stellar classification (O,B,A,F,G,K,M,W, L, T).  

70) The slider at the bottom of the list determines how many stars will appear in the list, from just 10 stars to as many as 500.  You have your choice of “nearest”, “brightest” or stars “with planets”.  For example, if you choose 500 stars with the slider and click the “brightest” dot, Celestia will list the 500 brightest stars in the sky as seen from your current position (apparent magnitude).  If you are in orbit around the star Polaris, it will list the 500 brightest stars as seen from Polaris.  

71) Planets orbiting other stars (Extrasolar planets) have been discovered in the last few years.  At last count, over 300 have been detected.  To give you an “up-to-date” astronomy experience, Celestia includes some of those planets placed around candidate stars.  In addition, Celestia’s many users have designed fictional solar systems that they have placed around some of the stars in our sky.  When downloaded, their solar systems will appear here in the star browser list also.  Selecting the “With planets” option will enable you to locate the stars that have planets, including fictional ones.  Remember though that the star has to be reasonably close to you.  This menu will only display the first 500 stars that have planets.  To practice such a journey, locate the star 51 Peg in the star browser list (make sure you choose the “with planets” option), and select “Go To”.  You will fly at great speed to a bright yellow star much like our Sun.  A planet will be seen near it.  Either point to it and left-click to select it, or right-click on the star 51 Peg when you get there and select the planet (named “b”).  Press the [G] key on the keyboard and you will be taken to the planet, which will appear as a big gas world similar to Uranus.  Using the movement keys described earlier, you can move around this planet.  Notice that the Solar System Browser in the Navigation Menu is no longer listing our solar system.  It now lists the one planet system of 51 Peg.  To return to Earth, press [H] to select the Sun, then [G] to go to it.


Eclipse Finder
72) The last menu item in the Navigation menu is Eclipse Finder.  When selected, Celestia will calculate and provide you dates of all partial and total solar or lunar eclipses for all planets and moons listed in the Solar System Browser, and offer you the option to go there to witness the eclipse.  Simply select the type of eclipse (solar or lunar), the planet and the date range you desire, and click “Compute”.  When a list comes up, pick one, click the “set date and GoTo the planet” button, close the dialog box by clicking the “Close” tab and enjoy the show.  We recommend you speed time up a bit by pressing the [L] key.

Important Notes:  To see eclipses, you must have “Eclipse Shadows” selected in the Render Options menu.  Also note that once you examine an eclipse, you will be in a new date in Celestia.  To return to your current date and time, press the [ Shift + ! ] key. 
 
There is a limit to what Celestia can calculate between dates that are far apart.  For example, Jupiter has 63 moons.  They all have the capability to pass between Jupiter and the Sun very frequently.  If you ask Celestia to compute a list of solar eclipses between say 1920 and 1990, the list will become so long that it will lock up the program.  Therefore, when dealing with the four outer gas giant planets of Jupiter, Saturn, Uranus and Neptune, (they all have lots of moons), please keep your request dates between a narrow range of a few months or less.   


Select Objects by Keystroke

73) There is another way to select planets.  The eight (8) planets in our Solar System have been given numbers from 1 for Mercury to 8 for Neptune.  9 is for the Dwarf Planet-Moon combination Pluto-Charon.  The Sun is number 0.To go to one of them, you can simply press the number at the top of the keyboard (not on the numeric keypad to the right) and hit the [G] key.  For example, pressing [3] and [G] will take you to the 3rd planet, Earth.  If you are in another (fictional) solar system, number keys will also work, but it will be that solar system’s objects that will be selected.  
74) If you press the [H] key, then [G], you will always be taken back to our Sun “Sol”, no matter where you are in the universe. 



Selecting Objects by Enter/Name/Enter Method

75) You can also select an object or a Location via a convenient keyboard command.  Hit the [Enter] key and the “Target Name” window will appear at the bottom of the screen.  Type the name of some object you wish to visit, such as a planet or moon or star or spacecraft, or location.  As you begin to type, Celestia will present you with a list of objects that begin with the letters you are typing.  For example, if you type the letter [M], Celestia will display a list of up to 12 objects in its data base that begin with an “M”, such as Mars, the Moon, Mir, Mercury, etc.  Note that the program has room to display only 12 objects.  Celestia, therefore, starts with all objects closest to you and displays the first 12 it finds in its database.  As you type the 2nd letter in your object’s name, the list will now display only those objects that contain both letters.  For example, typing “Ma” will reduce the list to only those celestial objects that begin with “Ma”.  You can complete typing the name, or you can simply press the [Tab] key to cycle the cursor from word to word in the list.  When you reach the word you desire, just press the [Enter] key again and Celestia will complete the spelling for you (auto-complete) and select the object.  Now to go there, press the [G] key.  
76) Try it.  Press the [Enter] key and type a single letter.  A list of objects will appear.  Type a 2nd letter.  The list will shorten.  Use the [tab] key, cycle through the remaining objects to any one you wish and press [Enter] again.  You will have selected that object.  Once selected, you can use all the object commands such as Center, Follow, Lock, Track, Goto, etc.
77) If you are seeking a named Location on a planet or moon, you must enter the name of the planet or moon where the location is found, as well as the location itself.  For example, instead of typing 'Cairo', you must enter 'Earth/Cairo' (or 'Sol/Earth/Cairo' if you're outside the Solar System.)  The slash mark / is needed.  

78) One problem that you may encounter is what to call an object.  You can use common names or Bayer and Flamsteed designations and HD or HIP catalog numbers when entering stars and space objects in all of the Navigation and Enter menus.  Galaxies are generally referenced by multiple catalog number designations (or Messier object references).  Celestia stores star data taken from the HD catalog or HIPPARCOS data set (the prefix is "HIP").  Both the 1st name or number and 2nd name of the object/star can be spelled out or abbreviated (3 letters), with a space between them.  Examples:
Upsilon And
Ups Andromedae
Ups And
51 Peg 	Note:  This is 51_Peg, not 51Peg
51 Pegasi
HD 173739
HIP 5643
Planets, moons, asteroids and artificial satellites may be named by their common name (e.g. Mir or Jupiter or Io), or they can also be specified using Celestia’s “path” syntax.  Type the name of the star, followed by a forward slash, then the planet name/, then the moon or satellite name, etc.  For example:
51 Peg/b
Sol/Earth
Sol/Earth/Moon/Apollo11
Sol/Earth/ISS
Sol/Jupiter/Europa
	
Galaxies are named by their common name or through their Messier number, NGC, UGC or MCG catalog numbers.  For example:
Pinwheel
M 101
NGC 5457
UGC 8981
MCG 9-23-28
   		All refer to the same object, the Pinwheel galaxy



Flying your Spaceship  [A], [Z], [S], [Q], [X]

79) What good is a space simulation program if you cannot fly around in it?  The worldwide fame of Celestia is due to its ability to give you the freedom to fly anywhere in the universe you desire, at any speed, in any direction and at any time in history.  The designers of Celestia have created a seamless and beautiful way to fly through the Celestia universe.  You are in command of your own hyperdrive spaceship.  The video screen in front of you is its window.  You can use this ship to fly through the Solar System, chase planets, drift above moons, try your hand at rendezvousing with spacecraft or visit another star.  Start some beautiful music playing and your journey can become more stirring.  Right now, your ship is stopped.  Let’s get it moving.  Click here, and you will be positioned about 10,000 km above the Persian Gulf.  
80) Now, press and hold down the letter [A] on the keyboard for a second or two.  This is the throttle for your spaceship.  You will begin moving forward.  Your direction is always directly ahead.  Your speed is shown in the lower left of the screen.  You will start slowly (in meters/sec).  As you hold down the [A] key, Celestia increases your speed exponentially.  Accelerate to between 40 and 50 km/s (50 kilometers/sec), which is much faster than our fastest planetary spacecraft (the Voyagers) have ever flown.  
81) To slow down, press or hold down the [Z] key.  Your speed will drop (the Brake).
82) Don’t worry about exact speeds, just get close.  Earth will begin getting bigger as you fly toward it on a collision course.  To change course, simply tap the arrow or other movement keys and your view (and forward direction) will change to a new orientation (the Movement keys can be found in paragraph 42).  
83) To reverse course instantly, simply press the [Q] key.  Now, you will begin flying away from Earth at the speed you selected.  Press [Q] again and you move forward again.  This command is useful if you overshoot a target.  Just reverse course and the target will again come into view in front of you.
84) To stop, press the [S] key.
85) A neat feature in Celestia is the ability to begin flying in a particular direction, then change the view out your window without changing your forward motion.  To do this, use the [X] key.  To illustrate, click here.  You’ll be in space to the left of Earth.  Now, press the [A] key and accelerate to about 2000 km/s.  You’ll move past Earth.  Now, press the [X] key and [left-click-drag] the scene so that you are looking at Earth.  Note that you are not flying toward Earth … you are still flying in your original direction but are able to look out your side window and see Earth receding from you.  Press [X] again and your ship will immediately change course to fly directly at what you’re looking at.  
86) Celestia gives you the opportunity to accelerate to a “hyperspeed” billions of times faster than light (c).  Just keep holding down the [A] key to speed up.  The [A] and [Z] keys are exponential speed controls.  As you gain speed, the stars will whiz by you like a scene from StarTrek.  You will quickly be taken out of the Milky Way entirely and into the blackness of the space between the galaxies.  You can journey to the very edges of Celestia’s universe.  There is not much to look at out there.  Swing the sky around and you may be able to notice some dim galaxies.  Generally, to see the Milky Way from outside of its confines, start your spaceship moving anywhere inside of our solar system, press the [Q] key to reverse course, accelerate to a warp speed of about 100 ly/s (light years/sec) and watch.  The stars and then the Milky Way itself will begin to recede from you.  Hit the [S] stop key and enjoy the view.  If you are following an object in our solar system, press [Ctrl+K] to turn on Markers, then press [Ctrl+P] to mark your object.  A green or red box will appear in the disc of the Milky Way showing you where our solar system resides.  To return, press the [H] and [G] keys, or hit the [Q] key to reverse course again, start your ship moving forward and you will fly back to your point of origin.  Please remember that Celestia only tracks a tiny few of the over 500 billion estimated stars in the Milky Way.  Galaxies contain FAR more stars than this program can track.
Celestia also provides shortcut keys for specific Spaceship speeds:
F1	Stop
F2	Set velocity to 1 km/s 
F3	Set velocity to 1,000 km/s
F4	Set velocity to speed of light
F5	Set velocity to 10x the speed of light.
F6	Set velocity to 1 AU/s
F7	Set velocity to 1 ly/s

You can use these shortcuts to get moving at a particular speed, then use the [A] or [Z] keys to boost or lower your speed further.



Telling Where You Are

87) Celestia will provide you a general idea of where you are in space by simply looking at the information view display.  The top left corner identifies which object you’ve selected and how far away from it you are.  By changing objects, you can determine a rough estimate of where you are in space.  However, if you have taken up position above a star, planet, moon, etc., Celestia will tell you not only how far you are from it, but what latitude and longitude above it you are positioned.  To see that, pull down the Navigation menu and select “Goto Object”.  As long as you have an object selected, you will see your Distance, Latitude and Longitude from it.  If you are completely lost, simply go home by pressing the [H] and [G] keys.


Adjusting Time (TIME MENU) [L], [K], [Shift+L], [Shift+K] [J], [Spacebar], [\], [!]

88) Many events in space take place at certain times.  Planets rotate at certain rates and experience seasons, spacecraft are launched and eventually fall back to Earth, moons eclipse the Sun on specific dates, comets pass by, space probes fly by target planets and take their measurements, etc.  Celestia gives you the opportunity to set a specific date and time, or to speed up or slow down the passage of time.  Your time will appear in the upper right corner of the screen.  For example, to see a planet turning under you, simply speed up the clock and it will rotate faster.  Conversely, since objects in space move at thousands of km/sec, they will disappear from view if you release your hold on them.  To slow things down a bit and watch them move away, you can slow down time. 
 
89) You can use the Time menu at the top of the viewscreen to change the passage of time.  Simply pull down the menu with your mouse and choose an option.  Celestia also provides simple keyboard shortcuts.  They are:

[Spacebar]	stop or pause time
[L]  		Time becomes 10x faster in powers of 10 (repeat for faster time)
[Shift+L]  	Time becomes 2x faster in powers of 2 (repeat for faster time)
[K]  		Time becomes 10x slower (repeat for slower time)
 [Shift+K]  	Time becomes 2x slower in powers of 2 (repeat for faster time)
 [J]  		Reverses time (it flows backward)
 [\]		Returns to Real Time
[Shift + !]	Sets time to the current clock time

90) For example, to see things move faster, position yourself hovering above Neptune and several of its moons by clicking here.  Notice that Neptune is not visibly turning (in real time, it takes 19 hours to turn once on its axis).  Now, press the [L] key three times to speed up time to 1000x faster.  Neptune will visibly turn below you and its moons will noticeably orbit the planet.  Slowing down time can also be useful when an object is spinning fast or passing by fast in its orbit.  Slow down time with the [K] key.

91) The date and time in Celestia is specified as year, month, day, hours, minutes, seconds, in a format called Universal time (UTC).  UTC time is also called Greenwich Mean Time, and is the time at the longitude of 0o, located at Greenwich England.  The reading 2009 Oct 22 17:44:11, means the year 2009, on October 22 at 17:44:11 UTC (5:44 PM Greenwich Mean time).

92) You can tell Celestia to use Local time by choosing that option in the Time menu.  If you are in the Eastern Time zone of the U.S. for example, your date will now read Eastern Time (Note:  Celestia uses the date and time zone assigned by the computer clock on your computer).  

93)   To change a date or a time in Celestia, pull down the Time menu and choose “Set Time”.  A dialog box will appear listing the date and time.  Left-click on either the date or the time, and press the [ß], [à], [á] or [â] arrow keys on the keyboard to advance or retreat in date or time.  When date and/or time has been set to your new choice, click OK and the menu will close.

94) You can also change the date manually by selecting the month, day, year, hour, minute or second with your mouse, then typing a new value.  For months, type 01 for January, 02 for February, 11 for November, etc.  You must type numbers from the top keyboard, not the numeric keyboard.

95) Resetting a date can be done with this menu command back in time to the year 9998 BCE, and forward to the year 9999 CE.  To type a year prior to 1 CE, type the number, then press the [-] key.  For example, to go back to the year 400 BC, type {400-} in the set time box.  Note, however, that Celestia’s orbital parameters are based upon epochs and variables that change slightly over the years.  Going back in time 2000 years or forward in time 5000 years will result in positions for solar system objects that will not be precise.

96) To set the time to the current date and time, choose the “Set to Current time” button in the Set Time dialog box, or press the [Shift+!] key on the keyboard.  

97) Important Note:  Celestia has programmed some of its spacecraft to appear in space and then actually fall back to Earth (disappear) on the day that they really did so.  For example, the Russian space station Mir was launched on 02/20/1986 and fell back to earth on 03/21/2001.  To see Mir in orbit above the Earth, you will have to reset the date to some period between those two dates.

Light Travel Delay  [ Shift+? ]  and [–]
98) Celestia has a feature called Light Travel Time Delay.  Light travels at a speed of 300,000 kilometers per second.  The sunlight we see on Earth actually left the Sun eight minutes before it reached your eyes.  Pressing the [Shift+?] key will display the one-way light travel time from the camera position to the currently selected object.  The minus [–] key toggles light time delay adjustment; if it’s turned on, a message will appear and the displayed time of day in the upper right-hand corner of the screen will have the light time delay subtracted.  If you move your position, the time with move with you.  Most lists of solar system phenomena give times that include light time delay.  When observing these events with Celestia, automatic light time adjustment is extremely helpful.  

99) For example, if a transit of a moon of Saturn is set to occur at 14:00 hours and you are one light hour away from Saturn, pressing the [–] key will reset the time to 13:00 hours, so that you can witness the event in real time.  If you press [Home] and move closer to Saturn, the time will decrease as you approach the planet.  Note:  Time delay does not function for stars, including our Sun.


FILE Menu –Scripts

100) FILE /Open Script  - Pull down the Celestia FILE menu and the first choice will be “Open Script”.  A script is a file with a .cel or .celx extension that commands Celestia to go certain places (or play sounds, if you have the special Celestia sound version).  It can also have text.  The short Night Sky DEMO you may have taken at the beginning of this document is controlled by a script named “Demo.cel”.  
101) Scripts are coded files written by Celestia developers and users to control certain Celestia program functions, and/or take you on a particularly interesting journey.  It controls the program and all you have to do is sit back and watch.  There are dozens of script files now available.  You can find many of them as add-ons in the Celestia Motherlode website.  Look for “script” in the add-on definitions.  If you do download a script, place the file into a folder named, “scripts” located inside your main Celestia directory.  Then, to launch/run the script, simply pull down the [Open Script] menu from the Celestia FILE menu, navigate to (look in) the location of the script file, and click on it to open it.  
102) A .celx script is a file that when run, has the ability to read the keyboard and wait for certain keystrokes to be pressed.  Press that key and some function will occur in Celestia.  The time may change, or a sound may play or the script may take you to a particular place.  Press a different key and a new function will occur.
103) To cancel a running script, simply press the [Esc] key at any time.
104) File/ “Scripts >” menu.  - When you pull down the File menu and select “Scripts >”, Celestia will display a list of all of the scripts in the Scripts folder.  You can then select one.  
105) As you become proficient in Celestia, you may want to try your hand at writing your own scripted journey.  To learn how, visit the Celestia Motherlode Scripting site at http://www.celestiamotherlode.net/catalog/scripts.php" http://www.celestiamotherlode.net/catalog/scripts.php.  Another excellent site is the “Wiki” website for Celestia, located at http://en.wikibooks.org/wiki/Celestia" http://en.wikibooks.org/wiki/Celestia .  Click on the “Scripting” section for a good overview of how to write scripts.  All scripting commands are outlined there, 
106) NOTE:  When a script is running, it may change some of the “Render” options that we discussed earlier.  For example, a script may turn off the clouds, or turn on Constellation labels.  When the script is done, it may not restore your Render options to their prior state.  We recommend that after a script has run, you go back to the Render menu and make sure your preferred options are set just the way you like them.  

FILE MENU - Capturing Images, Movies

107) Celestia gives you the opportunity to capture and save the scene on your screen as an individual graphic file (such as the figures seen in this User’s Guide).  You can also save a movie file and play it back later in your computer, embed it in a slide presentation or put it on YouTube or a networking site.  

Save Image  [F10]
108) To save a graphic file (in .jpg or .png format), simply set up the screen exactly as you want it, pull down the “File” Menu and select “Capture Image” (or press the [F10] key).  A menu will appear.  Choose the folder you wish to put the file into, name the file, decide if it is to be saved as a .jpg or .png file and click “SAVE”.  JPG files are common graphic files that have good quality and occupy less computer memory because they are first compressed by the program into a “smaller” size for storage.  Compression, however, always results in some small loss of image quality, in exchange for smaller file size.  Thus, .jpg images can be convenient to use in e-mails, websites and documents where quality is not overly critical, and too large an image size might slow down the software or make it difficult to transfer over the internet.  
109) PNG files maintain a higher image quality due to the way they save data.  As a result, they do require much more computer memory.  For example, an image save by Celestia might use about 60 KB of RAM memory in .jpg format, and 360 KB of RAM if saved as a .png file.  If you wish to use a Celestia image in a high quality presentation requiring the best image, save the file in .png format.  Note, however, that the bigger your monitor, the larger will be your saved image (since it is a screen capture).
110) To view a .jpg or .png image, double-click on it and your default graphic image viewer or browser in your computer will open it.  You do not need Celestia running.  You can paste and view images anywhere you wish.

Save Movie
111) Celestia gives you the opportunity to create an animation/movie of anything you experience in the program’s universe.  For example, if you wish to position yourself beyond Jupiter and fly past it at high speed with the planet whizzing by, you can record that maneuver in a movie.  You can record a rare solar eclipse as it happens or demonstrate the occultation of a star by a planetary limb.  You can execute any command you wish while taping a movie.  For example, you can accelerate in your spaceship, move the screen with your mouse, zoom in or out, speed up time, etc.  In this manner, you can set up your own movie “demo” of celestial places or events for others to see.  
112) To save a movie file (in .avi format), set up the screen as you want it and set the time moving forward at the speed you desire.  We suggest you then temporarily pause time with the [Spacebar] key while you complete the movie preparations.  Pull down the “File” Menu and select “Capture Movie”.  Choose the folder you wish to put the movie into, and type a file name for the movie.  Then choose the size of the video.  Generally, “320x240” or “640x480” file are the preferred sizes.  320x240 creates a smaller sized image and requires less computer RAM to store.  640x480 and higher are larger sized sets of frames and require considerably more RAM.  Next, choose a frame rate.  We recommend “24 frames per second”.  24 fps is used in film, 25 fps is used for PAL (Europe) video and 29.97 for NTSC (US/Canada) video.  15 fps is often adequate for displaying video on the web.  The lower the frame rate, the smaller is the size of the file that is stored.  This is something to consider.  A 2-minute movie can require over 100 MB of RAM when saved in fast and larger frame rates. 
113) Click “SAVE”.  Another menu will appear, asking if you wish to save the file compressed or uncompressed.  A compressed file requires less disk space than an uncompressed file, but may not look as good when played back, and the process of compressing video can dramatically slow down Celestia.  Celestia is set to save movie files uncompressed.  To save a compressed file, choose the format you desire.  You may wish to try different choices and determine which one works best for your computer.  The free DivX video codec available from www.divx.com provides excellent compression and quality, and is quite fast.  If you want to create many video files with Celestia and are concerned with file size, we recommend you download and install DivX onto your computer, then save your videos as a compressed DivX file.   
114) Click “OK”   A red box will now appear on your screen.  You can move what is in that box by clicking on the screen with your standard movement keys.  When ready to start taping your movie, start time moving forward if it was paused (press [spacebar] again), and press the [F11] key on the keyboard.  Recording will begin.  To stop, press the [F12] key.  The recording will stop and the red box will disappear.  Your movie is saved.  To cancel a movie at any time, simply press the [F12] key.
115) You can download a variety of video processing software from the net that can convert your video to other formats, such as MOV, MPG, MPEG or WMV.  Many of them are free software.  By combining your movies with audio, you can create a feature film!!!  Several Celestia videos are available on YouTube.  Just search for the code word, “Celestia”, or on an Astronomy topic of interest. 


Capturing Bookmarks

116) If you like a particular location and would like to return to that exact spot and time quickly, Celestia can save your location internally within the program as a “bookmark” or as an external “hyperlink” which can be pasted into another software program.

 Save Location (BOOKMARKS)  
117) To save a particular location, simply set up your position and time as you would like it, pull down the Bookmarks Menu and choose Add Bookmarks.  Type a name and click OK.  Celestia will save a positional and time bookmark in its database.  To return to that location at the exact time you saved, simply click on the Bookmarks Menu again whenever you wish, choose a saved location from the list and you will go there instantly.  To delete a location, rearrange the list or otherwise organize them, use the Organize Bookmarks option in the pulldown menu.  The Location/Bookmarks feature is very handy to have and use.  For example, if you have taken some time to position yourself in a particularly good view location in space or at the beginning of a celestial event, save that position with a bookmark and you can come back to it or show others the same event by an instant click on the bookmark.
118) Bookmarks are saved in a file in the Celestia main directory named “favorites.cel”.


 Cel: //URLs  [Ctrl+C] or [Ctrl+INS]

119) Celestia makes it possible to share locations and export them out of the program by inserting them in a web page or another document, through cel: //URLs.  A cel: //URL is a string of text (a hyperlink) that contains your current ship location, orientation, time, render options and field of view.  With it, you can take a snapshot of your precise position, time and view in space, and save it as an external hyperlink (a URL).  If you then paste that text string into a document that recognizes hyperlinks (word processors, web browsers, notepads, etc.), a user clicking on that link will automatically launch their own copy of Celestia and be taken to the exact position in space that you were viewing.  It can be used anywhere you would use an http hyperlink.  Obviously, the user must have Celestia on their computer for this feature to work.  
120) For example, cel: //urls have been used extensively in this document to take you to different locations associated with the figures.  Another example below is a cel: //url that captures the position of Phobos, one of Mar’s moons, orbiting high above the planet in January 2000.  Click on the link below, and you will be taken to that exact position, time and place in Celestia.
				          Click here for a ticket to Mars
[image: ]


Figure 43 – image captured via cel://URL





121) Please note that cel: //URLs are hyperlinks.  You should only click on them once (single-click, not double-click).  In fact, if you click one twice, it will launch two copies of Celestia at once.  Since Celestia uses a great deal of computer memory, two running programs could lock up your computer.  If everything seems to stop or slow down after using a cel: //URL hyperlink, or if the screen view does strange things, you probably clicked it twice.  Close one or both of the Celestia programs, reclick just once, and things should improve.  

122) To save your position in Celestia as a hyperlink, press either [Ctrl+C] or [Ctrl+INS] keys (Note – INS is an abbreviation for the “Insert” key).  This will save the hyperlink to your computer clipboard.  To paste that link into a text document or a PowerPoint presentation, you may be able to simply paste the link by positioning the cursor on the page and pressing “Paste” from the toolbar menu, or [Ctrl+V] from the keyboard.  If successful, the link will paste into your document and change color when you hit the Enter key.  Clicking on it will launch Celestia.  If that doesn’t work, you may have to paste the link by “inserting a hyperlink”.  See your application software for directions on how to do that.  In some applications, you can also link a Cel://URL to an image.  For example, right-clicking on graphic images in word processing and presentation software such as Microsoft Word or PowerPoint will usually offer you the option to “insert a hyperlink”.  If you select it, paste the Cel: //URL into the hyperlink address.  Clicking on the picture itself will then launch Celestia.  To see this in action, return to figure 43 above and this time, click once on the image, not on the text above it.  You will be taken to Phobos orbiting Mars.

123) As evidenced in this document, Cel://URLs are ideal for showing others a particular discovery or position made in the world of Celestia.  For example, perhaps you’ve positioned yourself to witness the passing of a Near-Earth asteroid as it whizzes past Earth, or have assumed a position off the North Pole of the Sun with orbits selected and the entire solar system orbiting below you.  Saving that location to a cel: //URL and pasting it on the web or in an e-mail or forum or blog for others to activate is an ideal way to share your Celestia experience.  You’ll find cel: // URLs also used frequently in the Celestia forum.

124) Note:  Be careful using cel: // URLs with add-ons.  If you save the camera position near a body that is part of an add-on you previously installed, someone who later clicks on the URL will see a very dull view of empty space unless they also have the same add-on installed.

Also please note:  When you click a cel: //Url, Celestia must reset your View Options to match the cel: //url commands (the same as in scripts).  When you are done visiting the location or enjoying the view that the cel: //url brought you to, there is no quick reset command to return your view settings to the way you had them before.  You will have to open the Render menu and make sure the check boxes you desire are again selected.  Alternatively, you can choose all of the options you desire and create your own cel: //url hyperlink as a “Bookmark”.  Call it “Reset”.  Then, if someone else’s cel: //url resets your program to settings you do not want, simply click on the Bookmark and Celestia will reset your parameters and take you to that location.

NOTE:  If Celestia is minimized in the taskbar tray (the bar at the bottom of your screen) and you click on a cel: //Url, it may result in the program doing some funny things.  It occasionally “gets lost”.  You may see the stars as bright dots instead of their normal appearance.  The screen may be warped.  You may wind up far from where you expected to be.  One easy way to tell if the program has gotten lost is to examine the “FOV” reading in the lower right corner.  If it is greater than 80o, the program is lost.  Fortunately, it is simple to overcome.  Maximize Celestia, then simply click on the cel: //url link again.  That usually does it! You must avoid minimizing the program when using cel: //urls.

Note:  Cel://URL’s created by Celestia 1.6.0 are referred to as “version 3”.  They cannot be used in earlier versions of Celestia.  However, earlier cel://URL versions 1 and 2 can be used in 1.6.0.


Multiview   (VIEW MENU) 
 
125) [image: ]Celestia can also show you views from different camera positions simultaneously.  This can be very helpful for visualizing phenomena like eclipses, where you want to watch a view from the Sun, the eclipsed planet or moon, and the occluding body all at the same time.  Planetary encounters by spacecraft are another category of events where multiple views can be illuminating.
126) When multiple views are enabled, one of the views is the active view and is marked by a thin highlighting frame around it.  All Movement commands will affect just the active view.  Other commands such as setting the time or date or Render menu commands are global, affecting all views.  New views are created through the keyboard commands of [Ctrl+U] and [Ctrl+R].  [Ctrl+U] splits the active view horizontally, leaving two identical views side by side.  Pressing [Ctrl+R] performs a vertical split that gives two vertically stacked views.  A newly created view can be further split by pressing [Ctrl+U] or [Ctrl+R] again; you can continue this until the views become impractically small.  The [TAB] key is used to cycle the active view.  A view that is no longer required may be removed by clicking your mouse on it and pressing the Delete [DEL] key.  [Ctrl+D] will delete all views except the currently active view. 
127) Views can also be created and deleted with the View menu.  The View menu also contains two additional options not available via a keyboard command.  When checked, Show frames puts a frame around each Multiview.  The other View menu setting is synchronize time.  Ordinarily, time is synchronized between all views, but if you deselect time synchronization, you can set the current time in each view independently by clicking within the view frame and using the Time menu to change the date or time.  Turning time synchronization back on resets the time in all views to that of the active view.  Note that the time rate cannot be set per-view; the rate commands and pause affect all views.		   	


Console Display  [Shift + ~], [pageup], pagedown]  
 
128) Celestia keeps a written log of what it is doing whenever it is loading files or textures.  That log can be displayed on screen to give advanced users an opportunity to see what is going on in the background of the program.  It is useful for troubleshooting (see below).
129) To access console mode, launch Celestia, then press the [Shift+~] keys together.  A running log display will overlay onto the screen.  To advance forward through the log, press [pagedown].  To advance backward through the log, press [pageup].  To cancel the log, press [Shift+~] again. 



Troubleshooting and Cautions (read carefully)

130) Some computers respond very sluggishly when Celestia is opened.  You may go to a particular location, and the screen moves in jerks rather than smoothly, or seems to freeze entirely.  It may occur no matter what angles you view an object from, or may only occur sporadically. Typically, it may occur when more than one drawn object is in the view (Earth and Moon both in the window, for example). Likewise, perhaps you’ve visited an object and it is exhibiting funny colors.  The cause of these performance problems may be as follows:
a) Your video card drivers are out of date.  This is a common reason for poor performance, particular for weird colors.  Celestia is sophisticated software that is continually undergoing updates and new versions to take advantage of newer video graphic rendering techniques.  You need to keep your video card drivers up to date as well, or the program may not perform properly.  To update a video driver, see prior sections.
b) The object you’re viewing may be larger in size than your video card can handle.  This too is a common occurrence.  Some add-ons include textures of planets or models of spacecraft that require 100 MB of memory just to load.  If you have two objects in view (e.g. - Earth and Moon), the program may be trying to use even higher video memory.  If your video card is not up to the task, the image simply will freeze on the screen.  
131) If Celestia is minimized in the taskbar tray (the bar at the bottom of your screen) and you click on a cel: //Url, it may result in the program doing some funny things.  It occasionally “gets lost”.  You may see the stars as bright dots instead of their normal appearance.  The screen may be warped.  You may wind up far from where you expected to be.  One easy way to tell if the program has gotten lost is to examine the “FOV” reading in the lower right corner.  If it is greater than 80o, the program is lost.  Fortunately, it is simple to overcome.  Maximize Celestia, then simply click on the cel: //url link again.  That usually does it! You should always avoid minimizing the program when using cel: //urls.
132) On occasion, you will find Celestia pausing a long time.  Perhaps the screen even turns white.  Be patient.  That means the program is loading a big data file and can take up to 10 – 30 seconds for it to load.  This is particularly true for media video files.
133) Sometimes, a computer is capable enough to run Celestia, but cannot run Celestia plus several other programs and documents (MS Word requires quite a bit of computer resources) at the same time.  If you are also running a music program and an internet browser, things can get real slow.  If that happens, close everything that is not absolutely needed for operating the computer. 


Other Documentation Available

This concludes the general User’s Guide to operating Celestia 1.6.0.  In addition to the Wikibooks and Wikipedia references made earlier, the Celestia community, has prepared a variety of other tutorial and manuals that teach you what image files are, how Celestia loads and uses them, how to create scripted journeys and how data files of various kinds are used to instruct Celestia in what to do and where to do it.  Look for them under the Documentation link at http://www.celestiamotherlode.net and in some of the web pages of Celestia contributors referenced earlier. 
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Celestia Keyboard and Mouse Command Summary

NASA has prepared a convenient graphical key chart, which is included below.  
You can print this page, or click on the image below, enlarge it and print it at any size you wish.
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(You can also print the following three pages as a convenient keystroke summary)
This command summary can also be accessed within Celestia.  Simply pull down the Help menu and click on “Controls”.
Celestia Keystroke Summary

Mouse Functions:
Left – click on object:		select object
Right drag:			orbit the selected object in any direction
Left drag:			orient scene in any direction
Rotate Mouse Wheel:		adjust distance to selection
Right + Left drag:   		adjust distance to selection
Ctrl + Left drag:   			adjust distance to selection
Shift + Left drag:   		change field of view (FOV) (e.g. => telescopic view)
Wheel (middle button) click: 	toggle field of view between 45 degrees and the previous field (e.g. telescopic view)
Left double click   			center selection
Right - click       			bring up context/select menu

Label Functions - Keyboard:

P	Toggle (turns on or off) planet labels
Shift+P	Toggle dwarf planet labels
M	Toggle moon labels
Shift+M	Toggle minor moons
E	Toggle galaxy and nebula labels
Shift+E	Toggle globular cluster and open cluster labels
B   	Toggle star labels
W	Toggle asteroid labels
Shift+W	Toggle comet labels
N   	Toggle spacecraft labels
=   	Toggle constellation labels
Shift + &	Toggle Location labels
Ctrl + K	Toggle Markers
Ctrl + P	Set a Marker
V   	Toggle info text 

Render Functions - Keyboard:
U   	Toggle galaxy rendering 
O   	Toggle planet orbits 
I   	Toggle clouds 
;  	Toggle Celestial grid (Earth-based equatorial coordinate sphere)
/   	Toggle constellation diagrams 
Ctrl+A 	Toggle atmospheres
Ctrl+B 	Toggle constellation boundaries
Ctrl+E	Toggle eclipse shadows
Ctrl+L 	Toggle nightside lights
Ctrl+S 	Toggle stars as points, discs or fuzzy points
Ctrl+T	Toggle comet tails
Ctrl+V	Cycle through vertex shading options
Ctrl+X	Toggle antialias lines mode
Ctrl+Y 	Toggle autoMag = auto adaptation of star visibility to field of view
Shift + ^	Toggle Nebula on or off 
[ 	If autoMag OFF:	Decrease magnitude (fewer stars visible)
	If autoMag ON:	Decrease magnitude at 45 deg field of view 
]  	If autoMag OFF:	Increase magnitude (more stars visible)
	If autoMag ON:	Increase magnitude at 45 deg field of view 
Shift +  { 	Decrease ambient light
Shift +  } 	Increase ambient light
Shift + (	Decrease galaxy brightness
Shift + )	Increase galaxy brightness
Shift + %	Toggle Star Color highlights
Shift + “+”	Toggle Limit of Knowledge textures
Alt+Enter	Toggle full screen display mode on or off 
Esc	Escape key = cancels command, cancels script, cancels movement or lock commands 



Navigation Functions - Keyboard:
H    	Select the Sun (Home)
C	Center on selected object
Shift + C	Center the orbit 
G	Goto selected object
Ctrl+G	Goto surface of the object
F	Follow selected object
ENTER	Select a star or planet by typing its name, then press Enter again
Y	Orbit the selected object at a rate synchronized to its rotation
.	Increase Field Of View (FOV)
,	Decrease Field of View (FOV)
Shift + :	Lock on selected object.  Point at 2nd object and press again to pair the two.
Shift + "	Chase selected object (orientation is based on selection's velocity)
T	Track selected object (keep selected object centered in view)
HOME	Move closer to object
END	Move farther from object
Up arrow	Your view pitches downward (also see # 8 key on numerical keypad)
Down arrow	Your view pitches upward (also see # 2 key on numerical keypad)
Left arrow	Your view rolls counter-clockwise (also see # 7 key on numerical keypad)
Right arrow	Your view rolls clockwise (also see # 9 on numerical keypad)
# 4 number key	on numerical keypad - Your view yaws (swings) to the left
# 6 number key	on numerical keypad - Your view yaws to the right
# 5 number key	on numerical keypad – instantly stops yaw, pitch or roll
Shift+arrow keys	Orbit around the object automatically
Shift + *	Look back view (rear view)
1-9	Select planets around nearby Sun
Esc	Cancel hold on object, cancel command or script action
Backspace	Cancel current selection

Time Functions - Keyboard:
Spacebar	Stop or pause time (or if paused, resume time)
L  	Time 10x faster (repeat for faster time) 
K  	Time 10x slower (repeat for slower time)
Shift+L	Time 2x faster
Shift+K	Time 2x slower
J  	Reverse time (it flows backward)
 \	Return to Real Time
Shift + !	Set time to the current clock time
Shift + ?	Display light-travel delay between observer and selected object
-	Subtract light-travel delay from current simulation time (toggle on or off)

Joystick Functions – typical  (Note:  joystick buttons differ in function – experiment with yours):
F8 	Enable joystick (press again to disable)
X axis 	yaw
Y axis 	pitch
L trigger	roll left	    (button C on a Microsoft Sidewinder Pro)
R trigger   	roll right	    (button D)
Button 1    	slower	    (trigger on Microsoft Sidewinder Pro)
Button 2	faster 	    (thumb button on Sidewinder Pro)

Multiview Functions - Keyboard:
Ctrl+R 	Split view vertically
Ctrl+U	Split view horizontally
TAB	Cycle active view
DEL	Delete active view
Ctrl+D	Delete all views except active one




Spaceship commands - Keyboard:
A	Increase velocity
Z	Decrease velocity
Q	Reverse direction
X	Lock/unlock movement direction toward the center of screen
S or F1	Stop
F2	Set velocity to 1 km/s 
F3	Set velocity to 1,000 km/s
F4	Set velocity to speed of light
F5	Set velocity to 10x the speed of light.
F6	Set velocity to 1 AU/s
F7	Set velocity to 1 ly/s




Other commands - Keyboard:
D		Run demo
F10		Capture image to file
F11 and F12		Start and stop Movie Save
Ctrl+INS or Ctrl+C	Copy location URL to clipboard (Windows)
`		Display frames per second (FPS) – useful for measuring Celestia response times
Shift + ~		Toggle Console Mode (shows text of what is going on in the background)
Page up		Moves the Console display up a few lines
Page Down		Moves the console display down a few lines
Ctrl+W		Toggle wireframe mode (displays objects as wireframe models)
F9		Toggle overlay texture
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